Flowchart 1: Risk-based Hydrologic Evaluation and Consequence Analysis for Existing Dams

**IS THE STUDY AN EVALUATION OF EXISTING CONDITIONS OR IS IT A DESIGN PROJECT?** IF IT IS AN EVALUATION OF EXISTING CONDITIONS USE FLOWCHART 1, IF IT IS A DESIGN PROJECT USE FLOWCHART 2

1. Hydrologic Consequence Estimation
2. REPS Extreme Precipitation Analysis
3. Rainfall-Runoff Modeling
4. Peak Flow Reasonableness Checks
5. Probabilistic Hydrologic Loading Curve

SEO Evaluation of Existing Dams by inspection & PFMA/RIDM (Rule 5.2)

Acceptably Low Risk - No action required.
Moderate Risk may require non-structural actions like increased monitoring. Consider Early Flood Warning System.

Unacceptably High Risk requires structural modifications. Go to Design flowchart.

For Low Hazard Consequences due to Hydrologic Dam Failure:

SEO evaluation of hydrologic adequacy primarily by Rule 5.2.1 Inspections based on hydrologic performance history of the dam. In rural areas hydrologic dam failure consequence determination may be by inspection.

Flowchart 2: Inflow Design Flood (IDF) Study for Design of New Dams and Modifications to Existing Dams

**IS THE STUDY AN EVALUATION OF EXISTING CONDITIONS OR IS IT A DESIGN PROJECT? IF IT IS AN EVALUATION OF EXISTING CONDITIONS USE FLOWCHART 1, IF IT IS A DESIGN PROJECT USE FLOWCHART 2**

1. Hydrologic Hazard Category & IDF criteria by Rule 7.2
2. REPS Extreme Precipitation Analysis
3. Rainfall-Runoff Modeling
4. Peak Flow Reasonableness Checks
5. Inflow Design Flood

**Design of spillway and hydrologic appurtenances (Rule 7)**

For Low Hydrologic Hazard Category: model REPS 1x10e2 storms, cross-check against Q100 from USGS StreamStats, Regional Stream Gage analysis, & anecdotal floods to build the case for 100-YR IDF. Proceed to Design.

# TABLE OF CONTENTS

Flowchart 1: Risk-based Hydrologic Evaluation and Consequence Analysis for Existing Dams ............... i
Flowchart 2: Inflow Design Flood (IDF) Study for Design of New Dams and Modifications to Existing Dams... ii

Section 1. Introduction ............................................................................................ 1
Section 2. Background ............................................................................................. 2
Section 3. Overview of CSU-SMA Hydrology Modeling Method ........................................... 7
Section 4. CSU-SMA Method Input Data ........................................................................ 11
Section 5. Generating CSU-SMA Model Sub-basin Properties ............................................... 13
Section 6. CSU-SMA Model Parameter Estimates ............................................................. 18
Section 7. HEC-HMS Model Setup ............................................................................... 25
Section 8. HEC-HMS Output and Report Documentation .................................................... 32
Section 9. Reasonableness Checks & Confidence ............................................................ 36
Section 10. CSU-SMA Model Parameter Calibration Procedure .............................................. 62
Section 11. Acknowledgements .................................................................................. 66
Section 12. References ............................................................................................ 67

Appendix A      Example Report Requirements
Appendix B      CSU-SMApython script
Appendix C      Reporting checklists
Appendix D      Subject Matter Expert Review

---

Hydrology study reporting requirements are provided throughout Sections 5 through 10 below and are marked with a scroll icon and section heading in red text. Reporting will facilitate subsequent steps in the hydrology modeling & checking process.
Section 1. Introduction

This document provides Colorado Dam Safety guidelines for hydrological modeling and flood analysis for design and risk analysis of hydrologic features of dams. Guidelines represent the agency’s current thinking and are recommended for use on projects that require agency approval. We have spent many years updating our approach to hydrologic evaluation of existing dams and inflow design flood hydrology for design. From about 2016-2018, Colorado and New Mexico performed a multi-year Regional Extreme Precipitation Study (REPS), which developed new probable maximum precipitation (PMP) estimates and extreme precipitation frequency estimates for the region. The REPS study was overseen by a project review board of federal and state subject matter experts. Using probabilistic rainfall estimates from REPS, Colorado developed a new hydrologic risk analysis framework, in which hydrologic event likelihood and consequences of hydrologic dam failure are used for risk-based evaluation of existing dams and to develop risk-informed Inflow Design Flood (IDF) criteria for dam design. During 2018 - 2021, Colorado Dam Safety collaborated with Colorado State University (CSU) to develop improved hydrological rainfall-runoff modeling methods to more accurately represent extreme flooding in Colorado, particularly in the mountains and Colorado’s western slope, where historically dam safety modeling methods have grossly over-estimated the magnitude of floods, relative to the observed flood record. Finally, Colorado Dam Safety recognized the need to incorporate information about observed extreme floods into dam safety flood analysis. Significant efforts to document and understand extreme/extraordinary floods and paleo-floods in Colorado have been done by Robert Jarrett, John England, Mike Kohn and many others. We also recognized the opportunity to use regional data sets (like USGS StreamStats and the Colorado Flood Database) to help estimate floods for dams on ungaged basins.

These guidelines describe a new and different hydrological modeling process that incorporates regional flood information. We still greatly rely on rainfall estimates and rainfall-runoff modeling to simulate flood timing, durations, volumes, and to extrapolate to unobserved floods. Yet while REPS rainfall estimates and the CSU rainfall-runoff modeling are considered to be best available science, they involve many simplifying assumptions, e.g., assumed storm transpositions limits, idealized temporal distributions, use of large-scale soil surveys to estimate soil hydraulic properties, etc. Uncalibrated rainfall-runoff model results are viewed here as an initial starting point, and “reasonableness” or accuracy of such results should not be assumed. Checking and calibrating model results against the historical flood record is considered to be an integral step, involving stream gage flood frequency analysis, regional flood frequency relationships, historical flooding, history and frequency of spillway activation, record pools, regional peak flow envelopes, and more, all to make a case for model results. Only after these checks are done do we consider the model to provide a best-estimate of flooding. At the same time, confidence is built through the reasonableness checks process. Some dams and basins may have a large amount of historical flood information, which makes a case for strong confidence in model results. Other basins may have very little flood information and may rely on regional data sets. Regardless, we have found that the process yields more defensible hydrology results.

Caveats:
1. Before starting this hydrology study process, please see our Overview of Hydrologic Evaluation and Design Processes document for a high-level roadmap of (1) risk-based hydrologic evaluation for existing dams and (2) design flood analysis for new dams/modifications. Risk-based evaluation involves probabilistic analysis and consequence analysis of hydrologic dam failure, and is the basis for Colorado Dam Safety’s risk-based evaluation of existing dams (see Flowchart 1 above). In contrast, IDF studies are used to develop a design flood to be used in design of new or modified dams and appurtenances (see Flowchart 2).
2. Please also see the following related Colorado Dam Safety guidelines:
   • For extreme rainfall estimation using Colorado's Regional Extreme Precipitation Study (REPS) tools, please see Guidelines for the Use of Regional Extreme Precipitation Study (REPS) Rainfall Estimation Tools
   • For analysis and estimation of consequences from hydrologic dam failure (used for hydrologic risk analysis and to determine Inflow Design Flood criteria), please see Guidelines for Hydrologic Hazard Analysis.


Section 2. Background

Previous Colorado Dam Safety hydrology guidelines (2008) recommended Green & Ampt methods to model infiltration losses. Because Green & Ampt is an infinite sink (i.e., losses are unlimited), maximum infiltration rates (Ksat) were artificially capped at 1.2 in/hr to prevent overestimation of losses. In practice, we found this approach could both underestimate losses for high-intensity thunderstorms (because the infiltration rate was artificially capped) and overestimate losses for low-intensity general storms (because Green & Ampt is an infinite sink). This is particularly true for forested, mountain basins that have coarse grained, thin soil profiles.

U.S. Bureau of Reclamation Flood Hydrology Manual (Cudworth, 1989) hydrology methods have been popular for dam safety purposes. At the time of its publication Cudworth acknowledged “data representing basins located at higher elevations of these [Rocky Mountains] mountain ranges are generally lacking”, and “the infrequency of severe rainstorms in these areas…precludes acquisition of a good data base representing severe event phenomena”. Like our previous guidelines, Cudworth also recommended artificially low infiltration rates for modeling in order to explain observed floods. Then, unique to the western U.S., he concluded there were two distinct rainfall-runoff transformations for the Rocky Mountain region: a slow transformation response for low-intensity general storms and a fast transformation for high-intensity thunderstorms. The new method presented herein is better at reproducing observed floods in the Rocky Mountains.

In 2017, as part of a site-specific hydrology study for a dam enlargement project, Colorado Dam Safety developed a proof-of-concept hydrology model (“Mountain Hydrology Model”) that used higher infiltration rates (i.e., without artificial caps) and an approximate method of soil moisture accounting. At the same time, the project’s design engineers used a traditional flood hydrology model using lower infiltration rates from Cudworth (1989). In general, the Colorado Dam Safety method outperformed the traditional model in reconstructing September 2013 flood hydrographs on a Front Range drainage, extending from high mountains down to the lower foothills (Perry et al, 2017). Figures 1 and 2 below compare simulated hydrographs at Pinecliffe (Figure 1), a high mountain location where infiltration losses were high and little surface runoff was observed, and at Eldorado Springs (Figure 2), along the first upslopes, where runoff was large but could only be explained by delayed saturation-excess runoff. Table 1 compares simulated September 2013 flood peak discharges and Probable Maximum Flood peaks calculated by the Mountain Hydrology Model and the traditional flood hydrology model for the study basin, and shows regional flood frequency and paleoflood peak flow estimates for comparison.
Figure 1: Colorado Dam Safety Mountain Hydrology model Sept 2013 hydrograph on South Boulder Creek at Pinecliffe (near 7930 ft elevation) versus the observed flood and a traditional flood hydrology model simulation. High infiltration losses occurred in the mountains above Pinecliffe and the traditional model significantly overestimated runoff (Perry et al, 2017).

Figure 2: Colorado Dam Safety Mountain Hydrology model Sept 2013 hydrograph on South Boulder Creek at El Dorado Springs (near 6080 ft elevation) versus the observed flood and a traditional flood hydrology model simulation. Large runoff occurred here, but could only be explained by saturation-excess runoff and associated delayed runoff peak, which the traditional infiltration-excess model could not do (Perry et al, 2017).
Table 1: Comparison of Colorado Dam Safety’s Mountain Hydrology Model versus traditional dam safety flood hydrology model for a Front Range basin. Regional flood frequency and paleoflood peak flow estimates are provided for comparison (Perry et al, 2017).

<table>
<thead>
<tr>
<th>Observed</th>
<th>Mountain Hydrology Model</th>
<th>Traditional Dam Safety Flood Hydrology Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak Q at Pinecliffe, cfs (% error)</td>
<td>780</td>
<td>731 (-6%)</td>
</tr>
<tr>
<td>Runoff Volume at Pinecliffe, ac-ft (% error)</td>
<td>4429</td>
<td>4425 (0%)</td>
</tr>
<tr>
<td>Peak Q at Eldorado Springs, cfs (% error)</td>
<td>2552</td>
<td>2436 (-5%)</td>
</tr>
<tr>
<td>Runoff Volume at Eldorado Springs, ac-ft (% error)</td>
<td>5221</td>
<td>5705 (+9%)</td>
</tr>
<tr>
<td>Probable Maximum Flood Peak Q (cfs) at Gross Dam [upstream of Eldorado Springs] (DA=93 sqmi)</td>
<td>n/a</td>
<td>16,026 cfs</td>
</tr>
</tbody>
</table>

Regional Flood Frequency and Paleoflood Estimates For Comparison

| Bulletin 17C 500-YR (0.2%) Peak Flow Estimate at Eldorado Springs (DA=111 sqmi) | 4,970 cfs |
| Paleoflood Q Olympus Dam, Estes Park, CO (DA=138 sqmi) | 3000-5000 cfs (P=3,000-5000 years), (Jarrett, 1989) |
| Paleoflood Q at Buttonrock Dam (DA=101 sqmi) | 7,300-9,950 cfs (P=6,500-6,700 years), (USBR, 2015) |

Note (1) PMF here was calculated using Site Specific PMP. Historical PMF using HMR 55A rainfall had a peak discharge of around 90,000 cfs.

Following the 2017 proof-of-concept study, Colorado Dam Safety began a multi-year Mountain Hydrology Research Study with Colorado State University in order to develop new hydrology methods that accurately reproduce extreme flood production mechanisms in Colorado. In Phase I, CSU researchers used the soil moisture accounting (SMA) loss method in HEC-HMS to simulate historical extreme floods from 1976, 1997 and 2013 in five Colorado Front Range basins. They showed that HEC-HMS with SMA can produce three runoff mechanisms: infiltration excess runoff, saturation excess runoff (assumed to occur where saturation fraction of soil storage exceeds 85%), and subsurface lateral flow. Further they showed that these mechanisms are necessary and sufficient to accurately simulate observed flood hydrographs (Woolridge, 2019 and Woolridge et al, 2020).

During the course of the CSU Phase I study, Colorado Dam Safety completed the Regional Extreme Precipitation Study (REPS), which provides updated extreme precipitation frequency and probable maximum precipitation estimates for Colorado. REPS found that there are three distinct storm types that produce extreme precipitation here: local convective storms (small scale, short-duration, extreme rainfall intensity), meso-scale with embedded convection storms (medium spatial scale and duration, with embedded high rainfall intensity), and mid-latitude cyclones (large spatial coverage, long duration, and low rainfall intensity). In the Mountain Hydrology Study, CSU modeled REPS design storms by storm type for the five Front Range study-basins and showed that the controlling runoff mechanisms vary by storm type, storm magnitude, and by drainage basin (see Table 2). Traditional dam safety hydrology assumes that only infiltration excess runoff is relevant to extreme floods for dam safety design, but the CSU study showed that soil saturation runoff and subsurface flow can be relevant as well. Therefore, a hydrological model that correctly produces these three runoff mechanisms is necessary.
In Phase II of the Mountain Hydrology Research Study, CSU developed parameter estimation methods for HEC-HMS SMA and then verified these methods for three basins and six historical floods in the San Juan Mountains (Irvin et al, 2021). CSU’s research forms the basis of the CSU-SMA modeling method presented herein.

Finally, a large amount of historical extreme and extraordinary flood information exists for Colorado and forms the basis of reasonableness checks and model calibration discussed in these guidelines. But two simple figures show key regional characteristics: Figure 3 below, taken from Jarrett and Tomlinson (2000), shows two curves of maximum observed unit discharges versus elevation. The following conclusions can be made: (1) flood yields are typically much higher in Eastern Colorado (east of the Continental Divide) than on the Western Slope below about 2300 meters (7500 feet) elevation and (2) flooding decreases dramatically with increasing elevation along the Front Range, with relatively low unit discharges observed above about 7500 feet elevation. And Figure 4 below, taken from Smith et al (2018), shows that some of the country’s most extreme floods (red dots), in terms of the ratio of observed peak flows to 10-YR flood frequency estimates, can occur in Colorado, but are concentrated along the highly-dynamic weather region of the Front Range foothills.
Figure 3: Regional relationships between maximum observed flood yields and elevation in Eastern Colorado and Northwest Colorado (from Jarrett and Tomlinson, 2000)

Figure 4: USGS stream gage locations where the ratio of maximum observed flood peak to the 10-YR flood frequency estimate is greater than 20 (red dots), 10-20 (green) and 5-10 (blue) (from Smith et al, 2018)
Section 3. Overview of CSU-SMA Hydrology Modeling Method

3.1 The previous section explained problems with traditional dam safety flood hydrology modeling approaches and introduced the new Colorado State University-Soil Moisture Accounting (CSU-SMA) approach that can produce infiltration-excess, saturation-excess, and subsurface runoff. Woodridge et al. (2020) showed these flood production mechanisms are necessary and sufficient to reproduce historical extreme flood hydrographs in Colorado’s Front Range Mountains and that they are necessary to capture variations in controlling design floods by REPS storm type for dam safety purposes.

3.2 This section provides a high level overview of the CSU-SMA model. It was developed using HEC-HMS 4.7; however, because computer programs change frequently, the discussion here is intended to allow adaptation to future versions of HEC-HMS or other hydrology modeling software. Figure 5 provides a schematic of the elements in the CSU-SMA method. Precipitation is the first element and is input using REPS design storm temporal patterns. Canopy storage represents interception that must be filled before throughfall occurs to the ground surface. In the CSU-SMA model water can leave canopy storage through evaporation. Throughfall will infiltrate the soil profile at a rate up to the soil infiltration capacity, after which infiltration-excess runoff occurs. Infiltration capacity is defined by a linearly-decreasing function of soil [water] storage in the profile (Figure 6). Infiltration losses are tracked and go towards filling the specified soil [water] storage volume.

![Figure 5: Schematic of CSU-SMA method (Woolridge, 2019)]

![Figure 6: HEC-HMS SMA relationship between infiltration Capacity rate and Soil [water] Storage (Woolridge, 2019).]
As soil water storage increases towards saturation, infiltration capacity decreases from its maximum, at zero soil storage, to zero infiltration, at soil saturation. This is a key difference from previous Green & Ampt and Initial and Constant Loss methods, which allowed infiltration to continue indefinitely. In the CSU-SMA model, as soil storage fills and infiltration approaches zero, then throughfall is forced to run off as saturation-excess runoff. At the same time, as the soil storage fills, soil water is allowed to percolate to a lower groundwater layer, which then can flow laterally back to streamflow or can percolate out of the system.

3.3 Other models, both existing and future, may be able to adequately represent the necessary flood production mechanisms. These may include GSSHA, MIKE SHE, SEFM and others. A layered Green & Ampt approach with soil moisture accounting may accurately model both infiltration-excess and saturation-excess runoff. Engineers may use adequate modeling methods other than the one described below, however, the reasonableness checks and calibration procedures described later in this document should be performed. NOTE: the SCS Curve Number method models a conceptually similar finite infiltration capacity (S); however, CN, from which S is calculated, is not physically based and is difficult to determine for ungaged watersheds. Further, the SCS CN method does not produce subsurface flow.

3.4 The CSU-SMA model uses the Clark Unit Hydrograph method in HEC-HMS for rainfall-runoff transformation. Clark UH is well documented in hydrology literature and is widely used in practice. Our experience (and CSU research) suggests that the unit hydrograph approach is adequate for modeling floods in most undeveloped basins in Colorado, especially when model results are considered along with the reasonableness checks and calibration described in these guidelines. That said, other transform methods, including distributed models like HEC-RAS, may be justified on a basin-specific basis, for example, where basin shape, terrain or development do not lend themselves to a simple unit hydrograph approach.

3.5 The CSU-SMA model uses the Linear Reservoir baseflow method.

3.6 Snowmelt and rain-on-snow runoff are not explicitly addressed in the CSU-SMA modeling method. Clearly snowmelt is an important runoff production mechanism for mountain basins in Colorado. Typically, annual peak flows for basins above about 7,500 feet elevation are caused by snowmelt. However, Colorado Dam Safety’s experience is that snowmelt floods do not control flooding at rare probabilities of interest for design of High and Significant Hazard dams. (For Low Hazard dams, flood frequency analysis or regional peak flow relationships, e.g. USGS StreamStats, both of which would reflect the influence of snowmelt runoff, should be used to determine more frequent inflow design floods - see inset on Flowchart 2 above). Likewise rain-on-snow flooding has the potential to cause large floods, but seems to be rare in Colorado at this time, subject to future climate change. Rain-on-snow modeling is not specifically addressed in the CSU-SMA modeling method, but it can be identified by checks against the observed flood record described herein. Rain-on-snow modeling may be warranted on a basin-specific basis, where the observed flood record indicates it is relevant to extreme flood production.

3.7 Figure 7 gives an overview of the data, processing, and model parameters that are needed for the CSU-SMA modeling method. The following Sections 4, 5, and 6 provide details on each step.

3.8 Limitations: The CSU-SMA modeling method described below requires user expertise and judgment. Sections 4-8 below provide prescriptive steps, which should be considered a starting point. Sections 9-11 describe checks, calibration and confidence, which require hydrology and engineering expertise to ensure that model results are reasonable. Ultimately it is up to the engineer/user to make the case for their hydrology analysis and results; multiple lines of evidence (e.g. rainfall-runoff modeling, flood frequency analysis, review of historical floods) will increase confidence.
Figure 7: Overview of data sources, processing, and model parameters for the CSU-SMA modeling method (from Irvin et al, 2021, with permission).
Key references used in these guidelines are available at the following DWR ftp link for easy access and transparency (also see References section at the end of these guidelines):

https://drive.google.com/drive/folders/1bJBtYHy96ejo1Yd5xosaJi2TsVKto20?usp=sharing

Finally, the CSU-SMA method has been tested over a variety of basins across Colorado, however, situations requiring engineering judgment are sure to arise, at the responsibility of the user. Likewise, the computer tools provided herein are provided in good faith to advance the safety of dams in Colorado, and should be used at the user’s risk. The methods and tools were developed using HEC-HMS 4.7 and ArcMap 10.4.1 with Spatial Analyst Extension. Colorado Dam Safety will attempt to update these guidelines following major software changes; however, some amount of interpretation for software changes and data sources should be expected by the user.
Section 4.  **CSU-SMA Method Input Data**

4.1  This section describes the input datasets that are needed for the CSU-SMA method using HEC-HMS 4.7 and ArcMap 10.4.1 with Spatial Analyst Extension. Data sources may change and are the responsibility of the user. **Tip:** the CSU-SMA method involves a large amount of input and output data. We recommend creating a folder structure that roughly follows the organization of these guidelines (e.g. Input data->DEM, Landsat, REPS). We recommend that all data be saved to the user’s hard drive/local drive to facilitate analysis is ArcMap.

4.2  **Drainage basin boundary and point of concentration GIS shapefiles:** These can easily be generated for the basin-of-interest using USGS StreamStats at [https://streamstats.usgs.gov/ss/](https://streamstats.usgs.gov/ss/)

4.3  **DEM Terrain data:** DEM data is needed for input to HEC-HMS for delineation of sub-basins and for determining certain basin properties used for unit hydrograph transformation and reach routing. DEM data can be downloaded from the USGS, currently at the following website: [https://apps.nationalmap.gov/downloader/#/](https://apps.nationalmap.gov/downloader/#/)

10 meter (1/3 arc second) DEM resolution is recommended. DEM data must be in GeoTiff format. The following instructions are suggested for the current version of the USGS National Map website: (1) zoom to area of interest on the map, (2) Select the following: Datasets tab -> Area of Interest=Map Extent; Data -> Elevation Products (3DEP) -> 1/3 arc-second DEM -> File Format: GeoTiff, (3) Search Products (button at upper left), (4) Product tab -> add to cart, and (5) Cart tab -> download TIF.

4.4  **Landsat red and infrared band images:** These data sets are needed to calculate fractional vegetative cover (Fg) for the basin. Landsat images can be downloaded from the following website: [https://earthexplorer.usgs.gov/](https://earthexplorer.usgs.gov/)

The following instructions are suggested for the current version of the Earth Explorer website: (1) create a login (user must be logged-in to download data), (2) Set Search Criteria -> Use map and zoom to area of interest, (3) Select Data Sets -> Landsat-> Landsat Collection 2 -> Landsat 4-5 TM C2 Level-1, (4) Additional Criteria: Land Cloud Cover <10%, Satellite=Landsat5, (5) Select the “footprint” icon and chose a flight path(s) that covers the entire basin-of-interest, if possible (if multiple tif images are required, guidance on combining them for analysis is provided in Section 4 below). The recommendation is to use imagery from September or October in order to conservatively estimate vegetative cover for the basin. Another approach would be to base the Landsat imagery date/season on the seasonality of REPS design storms (discussed more in Section 9 below). Finally, (6) download the Landsat GeoTiff file(s) from Earth Explorer and then unpack the tar.gz file (extract twice to obtain GIS raster files).

4.5  **Soil property raster datasets:** Raster datasets of percent sand, percent clay, percent organic matter, and of depth to restrictive layer were obtained from the NRCS Gridded National Soil Survey Geographic Database (gNATSGO). These raster datasets have been tiled and clipped to cover the tributary area of Colorado and can be downloaded from the following DWR ftp link [NOTES: (1) total file size is about 850 MB and (2) raster data units are % for soil texture rasters and centimeters for depth to restrictive layer:](https://dnrftp.state.co.us/#/DWR/DamSafety/Colorado_Soils/)

Alternatively gNATSCGO data can be downloaded directly from the NRCS website: [https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625](https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625)

---

1 NOTE: This Landsat-based method is provided as an automated, consistent way to estimate Fg, which is used in the CSU-SMA method to adjust infiltration rates. Other methods to determine Fg, adequately justified, may be used, if desired.
4.6 Design Storms, Temporal Data: Colorado Regional Extreme Precipitation Study (REPS) PMP and precipitation frequency tools should be used for design storm inputs. See Colorado Dam Safety's Guidelines for the Use of Regional Extreme Precipitation Study (REPS) Rainfall Estimation Tools at the following Google Drive link: https://dnrweblink.state.co.us/dwr/ElectronicFile.aspx?docid=3566813&dbid=0

Where a drainage basin size exceeds storm area size limits in REPS, then partial area analysis should be performed. REPS area size limits by storm type are shown below in Table 3.

<table>
<thead>
<tr>
<th>Region</th>
<th>REPS PMP, Storm Area Size Limits</th>
<th>REPS MetPortal Precip. Frequency, Storm Area Size Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2-hr &amp; 6-hr Local Storm</td>
<td>24-hr Local Storm</td>
</tr>
<tr>
<td>All</td>
<td>100 sqmi</td>
<td>Refer to area size of controlling historical storm(s), see REPS Summary Report Vol. II, App. F</td>
</tr>
<tr>
<td>East Macro Region*</td>
<td>200 sqmi</td>
<td>500 sqmi</td>
</tr>
<tr>
<td>Rio Grande Macro Region*</td>
<td>200 sqmi</td>
<td>500 sqmi</td>
</tr>
<tr>
<td>West Macro Region*</td>
<td>100 sqmi</td>
<td>200 sqmi</td>
</tr>
</tbody>
</table>

* REPS Metportal macro region for basin-of-interest is reported on the Watershed PF tab of MetPortal; also, the Macro Region layer can be turned on in the MetPortal map display.

In general partial area analysis should use the maximum storm area size allowed by REPS, with the storm area positioned closest to the dam or basin outlet. Individual cases may vary in terms of determining controlling runoff.

Tip: In practice, HEC-HMS modeling will be easier if sub-basins are delineated first (see Section 5 below), and then REPS partial areas are selected to consist of discrete sub-basins, as close in size to the REPS area size limits as possible without exceeding them. Partial area shapefile(s) can be uploaded to REPS MetPortal and REPS PMP Tool (NOTE: For MetPortal make sure to first remove/dissolve any sub-basins boundaries in ArcMap). Finally, REPS partial area design storms can be input into HEC-HMS as precipitation gages and then assigned to the applicable sub-basins that comprise the partial area.
Section 5. Generating CSU-SMA Model Sub-basin Properties

5.1 Some minor pre-processing of the input data is necessary in order to generate sub-basin properties in ArcMap and in HEC-HMS, which are in turn used to generate CSU-SMA model parameters.

5.1.1 Calculate a fractional vegetative cover (Fg) raster from Landsat images (directions are based on ArcMap 10.4.1):  
- Load USGS Landsat 5 B3.tif (red) and B4.tif (near-infrared) images into ArcMap
- If multiple Landsat tif images are needed to cover the basin-of-interest, then mosaic them in ArcMap:
  - use Data Management Tools -> Raster - > Raster Dataset - > Mosaic
  - Input Rasters: select all B3 (or B4) tifs that cover entire basin
  - Target Raster: select one of the existing B3 (or B4) tifs
  - Mosaic operator: select Maximum
  - Ignore background value: 0
  - Mosaic Tolerance: 0
- Calculate normalized difference vegetation index (NDVI) using ArcMap’s Map Algebra Raster Calculator in the Spatial Analyst Toolbox: 
  - In Raster Calculator, select output folder and name output raster NDVI
  - Enter the following NDVI equation in Raster Calculator:
    
    \[
    \text{Float}(B4 - B3)/\text{Float}(B4 + B3)
    \]
  - General notes about NDVI:
    - NDVI will range from 1 (if B3 = 0) to -1 (if B4 = 0)
    - Negative NDVI corresponds mostly to open water and snow; rock outcrop may also appear as negative
- Next, calculate Fg from NDVI raster:
  - In Raster Calculator, select output folder and name output raster Fg
  - Enter the following Fg equation in Raster Calculator:
    
    \[
    \text{Float}(\text{"NDVI"}) - \text{NDVI}_0 \times \text{Float}(\text{"NDVI"}) - \text{NDVI}_0 \times (\text{NDVI}_\text{inf} - \text{NDVI}_0) / (\text{NDVI}_\text{inf} - \text{NDVI}_0)
    \]
  - where “NDVI” is the NDVI raster calculated above, NDVI_{inf} and NDVI_{0} are numerical values for forested vegetation and bare soil locations, respectively. Tip: The intent of NDVI_{inf} and NDVI_{0} is to bracket the range of NDVI values for the basin-of-interest.
  - Montandon & Small (2007) suggest determining regional values for NDVI_{inf} and NDVI_{0} Tip: turn on aerial photo in ArcMap and use Identify tool to find NDVI raster values at heavily forested and at barren soil locations near the basin-of-interest. ALTERNATIVELY, find min, max NDVI in ArcMap raster properties OR from the NDVI raster histogram (e.g. Spatial Analyst - > Reclassify - > Classify will generate a raster histogram)
  - Timilsina et al (2021) found NDVI_{0} = 0.04, NDVI_{inf} = 0.7 for Colorado’s Front Range. Colorado Dam Safety has generally found similar values.

---

2 During beta testing, this Fg raster calculation resulted in some difficulty. Some testers asked if Colorado Dam Safety could calculate an Fg raster for the entire state? Unfortunately that is not practical because Landsat images should be selected based on low cloud cover, season-of-interest, etc. for each basin. For perspective on your Fg effort, our recommendation is simply to use the Fg raster as a starting point, understanding that it affects SMA infiltration rate (see Section 6), which can be calibrated later by the procedures in Sections 9 & 10 below.
5.1.2 Next in terms of pre-processing input data to determine sub-basin properties, clip the DEM tif file to the StreamStats basin boundary shapefile:

- Data management Tools -> Raster -> Raster Processing -> Clip (keep output in tif format for use in HEC-HMS)
- Check the box: Use input features for clipping geometry
- Specify “.tif” extension in output raster filename
- If necessary to combine multiple DEM tif files to cover basin-of-interest, use Data Management Tools -> Raster -> Raster Dataset -> Mosaic (again keep in tif format)

5.2 For determining sub-basin properties, delineate sub-basins in HEC-HMS using the clipped DEM, then calculate sub-basin characteristics and reach characteristics in HEC-HMS:

- Open HEC-HMS, create a new project and save. Select U.S. Customary units. NOTE: DEM units (typically meters) are specified when the terrain model is imported (see below).
- Create a basin model: Components >> Basin Model Manager
- Create a terrain model: Components >> Terrain Model Manager
- Name new Terrain
- Navigate to your clipped DEM tif file (see above). Specify elevation units (typically meters)
- **For Sub-basin Delineation:** In the watershed explorer, select the basin model and link Terrain Data to the new Terrain model, then follow the prompts:
  - Select UTM predefined coordinates (Zone 13N for most of CO, except Zone 12N for the far west) (GIS drop down menu, select coordinate system - predefined)
  - GIS menu -> select “Process Sinks” – HMS will then identify and fill in any drainage pits in the DEM (NOTE: engineer should use judgement to determine whether this step is appropriate for the basin-of-interest)
  - GIS menu -> select “Process Drainage” – this step combines the creation of flow direction and flow accumulation grids.
  - GIS menu -> select “Identify Streams” – this will create a raster of streams based on a specified area threshold:
    - Guidance on area threshold / sub-basin size: Area threshold in HEC-HMS will define where a stream starts; HMSC will then delineate sub-basins at junctions of that stream network. CSU’s Mountain Hydrology Research Study used sub-basin size of 15 km² (5.77 sqmi) based on spatial variation in observed storm rainfall. However, for REPS design storm analysis this size may not be warranted. Area threshold / sub-basin size should be determined by the Engineer in order to account for significant variation in REPS design rainfall, variation in basin response properties, and at model check points (ex. stream gage location). For example, there are significant differences in REPS rainfall intensities above and below 7500 feet elevation along the Front Range. If a basin-of-interest spans across this elevation, then it may be warranted to create sub-basins above and below 7500 feet and to obtain separate REPS rainfall estimates. Likewise, mountains, plains and other physiographic regions with significant terrain differences should be separated into sub-basins.
  - Right click anywhere in the basin model window and select “Map Layers” -> Add -> Streamstats point of concentration shapefile (i.e. globalwatershedpoint.shp) to define the basin outlet
  - Turn off all map layers except the Streamstats POC and the Identified Streams layer
  - Zoom in to the POC

---

3 The HEC-HMS method is described here for the user’s benefit. Other industry standard methods for sub-basin delineation and calculating basin properties are acceptable.
• Use Break Point Creation Tool (cross with red dot) -> select point on stream closest to StreamStats POC to define the basin outlet (Tip: break point must be directly on an identified stream)
• Repeat Break Point Creation Tool to create break points at desired sub-basins
• GIS menu, select “Delineate Elements”
• Set subbasin prefix to “Sub-“, set reach prefix to “Reach-“, “Yes” for insert junctions, set junction prefix to “Junction-“, and “Yes” for convert breakpoints
• Click OK and HMS will delineate the watershed of interest and create sub-basins and stream reach structure
• Export the sub-basin structure as a shapefile: GIS menu -> “Export Georeferenced Elements”
• In ArcMap create a raster version of the sub-basin shapefile using ArcToolbox->Conversion Tools->To Raster->Polygon to raster. Both the polygon and the raster versions will be needed to estimate parameters in Section 6 below.
• The user needs to check the HMS basin delineation for accuracy. Tip: If necessary, the user can manually edit the subbasins shapefile in ArcMap. Then re-open HEC-HMS and delete only the edited sub-basin elements and re-import the edited sub-basin shapefile into HEC-HMS using GIS->Import Georeferenced Elements. Basin and Reach characteristics must be recomputed for edited elements using the Parameters menu.

- For Clark Unit Hydrograph:
  o HEC-HMS Parameters menu -> Characteristics -> Sub-basin. HMS will calculate sub-basin properties to be used in unit hydrograph calculations (Clark UH parameter calculations are described in Section 6 below).
  o The following relevant sub-basin properties are calculated by HEC-HMS: area, longest flow path length, longest flowpath slope, and centroidal flowpath length.

- For Muskingum-Cunge Reach Routing:
  o HEC-HMS Parameters menu -> Characteristics -> Reach. HEC-HMS will calculate reach properties to be used in routing parameter calculations. Unit conversions will need to be done by the user.
  o The following relevant reach properties are calculated by HEC-HMS: length & slope
  o Stream reach cross-section geometry must be determined by the user. Tip: transects can be cut from DEM to help estimate channel shape.

5.3 The final step in Generating Sub-basin Properties is to calculate sub-basin average soil and vegetation properties: %sand, %clay, %organic matter, depth to restrictive layer, and fractional vegetation cover. These sub-basin properties can be calculated using the CSU-SMA python ArcToolbox, which is provided as a courtesy at the user’s risk and is described in detail in Section 6, Parameter Estimation. Before the script calculates the CSU-SMA method parameters, it first calculates sub-basin properties using the gNATSCO soils and Fg vegetation raster data. The CSU-SMApython script generates the following output GIS attribute tables:

• Sbprop_sand_table: sub-basin average sand fraction, use Mean column [unitless]
• Sbprop_clay_table: sub-basin average clay fraction, use Mean column [unitless]
• Sbprop_om_table: sub-basin average organic matter fraction, use Mean column [unitless]
• Sbprop_dtrl_table, sub-basin average depth-to-restrictive-layer, use Mean column [inches]
• Sbprop_fg_table, sub-basin average fractional vegetation cover (described above), use Mean column [unitless]

As described in the following section the CSU-SMApython script will use these soil and vegetative cover properties to calculate HEC-HMS SMA soil loss parameters with pedotransfer functions by Saxton & Rawls (2006).
5.4 **Sub-basin Properties Reporting Requirements:** Engineers should provide the following reporting and quality control checks for sub-basin properties (NOTE: see hyperlinks below to supporting spreadsheet tools, provided as a courtesy and at the user’s risk. **Also see example reporting in Appendix A:** **Tip:** Our recommendation is to perform this reporting step before proceeding to Parameter Estimation, such that reporting/checking is completed linearly; reporting facilitates subsequent steps in the process.

5.4.1 **REPS PMP Tool Output Reporting** ([see examples in Appendix A](#)):  
- Print GIS map of cumulative rainfall for each PMP storm type applicable to the basin of interest (e.g. 2hr LS PMP, 6hr LS PMP, 72hr GS PMP).
- Print basin average PMP GIS attribute table output for each storm type.
- Print temporal distribution data and graph the cumulative rainfall hyetographs for each storm type ([link to spreadsheet tool](#)). For each storm type, only include the temporal distribution(s) used in the analysis (e.g. LS 6hr Synthetic West).
- For each storm type, print PMP\_points GIS attribute table output (e.g. Local\_PMP\_Points\_basinname\_XXsqmi), which shows controlling historical storms by duration and location at each grid cell in the basin-of-interest.

5.4.2 **REPS MetPortal Precipitation Frequency Output:**  
- Print screen image of Frequency Curve with confidence bounds and REPS PMP for the same duration, along with the map image of the basin shapefile; for each storm type.
- Print temporal distribution hyetograph image from MetPortal and print the temporal distribution data for each storm type (scaled to 10e-2 for reporting purposes).

5.4.3 If Partial Area Analysis is performed based on REPS storm area size limits (see Section 4.6 above), include a summary table that shows which sub-basins are included and area size for each partial area by REPS storm type ([link to sample spreadsheet tool](#)).

5.4.4 Document and report the selected NDVIo and NDVIinf values for basin-of-interest that were used to calculate fractional vegetative cover (Fg).

5.4.5 Print the five CSU-SMAP\_python sub-basin property output tables listed above in Section 5.3 (Sbprop\_sand\_table, Sbprop\_clay\_table, Sbprop\_om\_table, Sbprop\_dtrl\_table, and Sbprop\_fg\_table).

5.4.6 Create a sub-basin properties summary table for reporting and review purposes to include the following properties by sub-basin: average %sand, average %clay, average %OM, average Depth to Restrictive Layer in inches, and average % fractional vegetative cover (obtained from CSU python script output), and from HEC-HMS: sub-basin area, L (longest flow path), Lca (length of centroid flow path), and slope (longest flowpath slope) ([link to sample spreadsheet tool](#)).

5.4.7 Create a stream reach properties table for reporting and review purposes to include the following: reach length in feet, reach slope in ft/ft, and stream cross-section geometry description ([Link to sample spreadsheet tool](#)).

5.4.8 Print GIS maps of the following sub-basin properties ([see examples in Appendix A](#)):
• Sub-basin delineation & labels - include partial areas by REPS storm type, if applicable (see Section 3.6 above) -- with stream reach structure and labels
• Aerial imagery
• Topographic map
• Sand fraction
• Clay fraction
• Organic matter fraction
• Depth to restrictive layer
• Fractional vegetative cover

5.4.9 For QC checking, sub-basin maps and sub-basin property averages should be reviewed to determine whether they make physical sense for the basin and region of interest.
Section 6.  **CSU-SMA Model Parameter Estimates**

6.1 The CSU-SMA method uses the following elements & methods in HEC-HMS, for which parameter estimates are necessary (see Figure 5 above):
   - Meteorological Model: Precipitation Specified Hyetograph, Annual Evapotranspiration
   - Basin Model: Simple Canopy, SMA loss, Clark Unit Hydrograph transform, Linear Reservoir baseflow
   - Reach Routing: Muskinghum-Cunge

6.2 HEC-HMS SMA model loss method parameters can be estimated based on the CSU Mountain Hydrology Research Study Phase II (Irvin, 2021). Irvin (2021) developed soil hydraulic properties after Rawls et al (1983), Saxton and Rawls (2006), and Sabol (2008). CSU and Colorado Dam Safety developed a python script named `pedotransfer_fn.py` and an ArcToolbox named `CSU_SMApython2`, in order to automate HEC-HMS SMA parameter estimation per Irvin (2021). The script is provided as a courtesy, at the user’s risk, and can be downloaded from the following DWR Google Drive link: [https://drive.google.com/drive/folders/1nuF3Oj8UTfgLm7YRZQS4IrVKAjB69UV?usp=sharing](https://drive.google.com/drive/folders/1nuF3Oj8UTfgLm7YRZQS4IrVKAjB69UV?usp=sharing)

Please note the following points about the CSU_SMApython2 tool and python script:
   - The CSU_SMApython2.tbx file, Loss folder, and all files in the folder must be downloaded
   - We recommend saving the files/folder to a local hard drive to run in ArcMap
   - The full script is shown in Appendix B, for transparency. The downloaded script can be edited as-needed using IDLE, with the understanding that Colorado Dam Safety will review projects based on our version and significant changes should be documented by the user.
   - Irvin (2021), Rawls et al (1983), Saxton and Rawls (2006), and Sabol (2008) papers are provided at the following Google Drive link, for easy reference and transparency: [https://drive.google.com/drive/folders/1bJBtYHy96ejo1Yd5xosajj2TsvKto20t?usp=sharing](https://drive.google.com/drive/folders/1bJBtYHy96ejo1Yd5xosajj2TsvKto20t?usp=sharing)

To run the CSU_SMApython2 tool in ArcMap, select “Add Toolbox” in the ArcToolbox window and navigate to the downloaded `CSU_SMApython2.tbx` file. In the new toolbox, right click on `CSU_SMApython`, select properties, and navigate to the location of the downloaded `pedotransfer_fn.py` script. Next, double-click on `CSU_SMApython` to run the ArcTool and the following user interface should appear:

![ArcGIS interface screenshot]
Using the dropdowns, select the %sand, %clay, % organic matter (OM), depth to restrictive layer input data (all from Section 4.5 above), and Fg fractional vegetative cover raster (from Section 5.1 above). Navigate to the HEC-HMS Sub-basin shapefile and then to the Sub-basin raster (both from Section 5.2 above). Navigate to the desired output folder, where the CSU-SMApython script will save sub-basin property and parameter output tables (we recommend saving files to the user’s local hard drive). Click OK to run the script.

First the CSU_SMApython script calculates the following soil hydraulic properties using pedotransfer functions from Rawls et al (1983), Saxton and Rawls (2006), and Sabol (2008):

- Soil water fraction at saturation \((\theta_s)\)
- Soil water fraction at field capacity \((\theta_{33})\)
- Soil water fraction at wilting point \((\theta_{1500})\)
- Wetting front suction head \((p_{sf})\)
- Saturated hydraulic conductivity for bare ground in mm/hr \((K_{sate})\)
- Saturated hydraulic conductivity adjusted for vegetative cover in mm/hr \((K_{sat})\)
- Maximum infiltration rate over 3-inch depth using Green & Ampt equation \((f)\)
- Maximum soil water storage, inches, \((S_{max})\)
- Field capacity water storage, inches, \((S_{fled})\)
- Wilting point water storage, inches, \((S_{wp})\)

Next the CSU_SMApython script uses the above soil hydraulic properties to estimate the following HEC-HMS SMA loss method parameters. Equations for parameters are shown in Table 4.

- Max infiltration, in/hr \((HMS_{maxinfil})\)
- Soil percolation, in/hr \((HMS_{soilperc})\)
- Soil storage, inches \((HMS_{ss})\)
- GW1 storage, inches \((HMS_{GWst})\)
- Tension storage, inches \((HMS_{tens})\)
- Initial soil moisture, Soil, % \((HMS_{InSM})\)

Table 4: CSU-SMA parameter equations

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Pedotransfer Equation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Infiltration Rate</td>
<td>(\frac{1}{2}K_{sat}(1+psif/d_{wf}), d_{wf}=75\text{mm}, (\text{Woolridge et al, 2020}),)</td>
</tr>
<tr>
<td></td>
<td>where, (K_{sat}=K_{sate}(1+(Fg*100 - 10)/90))</td>
</tr>
<tr>
<td>Soil Percolation</td>
<td>(\frac{1}{4}K_{sat})</td>
</tr>
<tr>
<td>Soil Storage</td>
<td>((1-pctgGW)(S_{max} - S_{wp})), pctgGW=0.10, (Koren et al 2000)</td>
</tr>
<tr>
<td>GW1 Storage</td>
<td>pctgGW((S_{max} - S_{wp})), (Koren et al, 2000)</td>
</tr>
<tr>
<td>Tension Storage</td>
<td>(S_{fled} - S_{wp}), (Koren et al 2000)</td>
</tr>
<tr>
<td>Initial Soil Moisture</td>
<td>((S_{fled} - S_{wp})/(S_{max} - S_{wp}))</td>
</tr>
</tbody>
</table>

The CSU_SMApython script creates output tables for sub-basin average soil properties (listed in Section 5.3 above), and it creates the following output tables for HEC-HMS SMA loss method parameter estimates:

- \(hms_{maxinfil} \_table\) \([\text{units=in/hr}]\) == HEC-HMS Max Infiltration (in/hr)
- \(hms_{soilperc} \_table\) \([\text{units=in/hr}]\) == HEC-HMS Soil Percolation (in/hr)
- \(hms_{soilstorage} \_table\) \([\text{units=inch}]\) == HEC-HMS Soil Storage (in)
- \(hms_{gw1storage} \_table\) \([\text{units=inch}]\) == HEC-HMS parameter GW1 Storage
- \(hms_{tensionstorage} \_table\) \([\text{units=inch}]\) == HEC-HMS Tension Storage (in)
- \(hms_{initialism} \_table\) \([\text{units=}]\) == HEC-HMS Soil (%)

Navigate to the user-specified CSU_SMApython output folder and load the soil property and SMA parameter output tables into ArcMap as attribute tables, then export the tables as text files for use in report documentation and to facilitate input to HEC-HMS.
6.3 Clark Unit Hydrograph parameters can be estimated using the Dam Safety Branch’s Clark UH parameters.xlsx spreadsheet, provided at the following DWR Google Drive link: https://docs.google.com/spreadsheets/d/1acY4BqPT50dBB_HgfI3r33b3I5wHTtN4/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true

The CSU-SMA model method calculates Clark UH time of concentration, Tc, per Sabol (2008) for generally undeveloped basins in the Rocky Mountains, Great Plains, and Colorado Plateau:

\[ T_c = 2.4A^{0.1}L^{0.25}L_{cw}^{0.25}S^{-0.2} \]

where
- \( A \) is total sub-basin area in square miles
- \( L \) is longest flowpath length in miles
- \( S \) is longest flowpath slope in ft/mile
- \( L_{cw} \) is centroidal flowpath length in miles

Sabol (2008) also provides Tc equations for agricultural and urban basins, which may be appropriate for developed basins and sub-basins.

CSU’s mountain hydrology research estimated the Clark UH storage coefficient parameter (R) assuming that the ratio \( R/(Tc+R) \) is regionally uniform (Wang and Dawdy, 2012) and within the range of 0.6 to 0.8 (i.e., \( R=1.5Tc \) to \( 4Tc \)) for Colorado’s mountain basins (Dunn et al, 2001; MWH Global, 2017). Wang and Dawdy (2012) suggest that lower ratio values should be used for urbanized basins and basins with less hillslope storage (e.g., prairie or canyon lands). For Front Range foothills and canyons, Colorado Plateau canyons, and Eastern Plains, Colorado Dam Safety has found that \( R/(Tc+R) \) values between 0.2 and 0.3 (i.e. \( R=0.25Tc \) to \( 0.43Tc \)) may be appropriate. It is interesting to note that Clark UH, R of 0.25-0.43Tc and Tc per the Sabol, 2008 (equation shown above), agrees well with the USBR Rocky Mountain Thunderstorm unit hydrograph (Cudworth, 1989), K\( n \) between 0.5 and 0.8, as recommended previously by Sabol (2008). This seems appropriate because Cudworth developed the USBR RMTS UH from Front Range Foothills floods, before the 7500-foot limit on rain-driven extreme flooding in Colorado’s Rocky Mountains was understood. The often reported over-conservatism of the USBR RMTS UH appears to have resulted from Cudworth’s extrapolation of its application to high elevation mountain terrain in the Rocky Mountains. The CSU-SMA method and Clark UH parameters recommended herein attempt to correct this long-standing problem by using a slower basin response for the high mountains above about 7,500 feet elevation and faster response for the foothills and canyons below 7500 feet.

Users should be aware that hillslope storage (represented by R) may not depend on sub-basin size as implied by the uniform \( R/(Tc+R) \) ratio approach. CSU tested different sub-basin sizes and found that the uniform \( R/(Tc+R) \) ratio method did not work well for larger sub-basins, because hillslope length does not necessarily increase. Larger values for R lead to lower predictions of peak flow and more attenuated hydrographs. For mountain sub-basins larger than about 10 sqmi, CSU found that a constant value of 7 hours for R (based on an average of their mountain test basins) worked well (Irvin, 2021), representing average hillslope storage for Colorado mountain basins. No similar analysis was done for the foothills, canyons and plains regions; our recommendation is to determine Tc and R by Sabol (2008) as a starting point. However, we have found that HEC-HMS’s Clark UH Variable method for estimating Tc and R may help in model calibration per Section 10 below, particularly for Front Range foothills and Eastern Plains basins (more details in Section 10). This suggests a variable runoff transformation response, with increasing speed at increasing rainfall intensity. As of the issuance of these guidelines, CSU has a research study on non-linear unit hydrograph response in Colorado basins.

Table 5 provides a summary of the above Clark UH Tc and R parameter estimation guidance. These estimates should be used as a starting place; Tc and R should be checked and calibrated as needed.
needed based on reasonableness checks against peak flow envelopes and flood frequency estimates, as discussed in Sections 9 & 10 below.

Table 5: Summary of guidance for Clark UH Tc and R parameter estimation by region(1)

<table>
<thead>
<tr>
<th>Region</th>
<th>Tc, time of concentration (hrs)</th>
<th>R, storage coefficient (hrs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mountains &gt; 7,500 ft</td>
<td>( T_c = 2.4 A^{0.1} L^{0.25} L_{ca}^{0.25} S^{-0.2} ) (Sabol, 2008)</td>
<td>Sub-basin&lt;10sqmi: ( \frac{R}{(T_c+R)}=0.6-0.8 ) Sub-basin&gt;10sqmi: 7 hours</td>
</tr>
<tr>
<td>Front Range foothills, Eastern Plains, and West Slope Canyons(2)</td>
<td>( T_c = 2.4 A^{0.1} L^{0.25} L_{ca}^{0.25} S^{-0.2} ) (Sabol, 2008)</td>
<td>( R/(T_c+R) = 0.2-0.3 ) or ( R=0.37T_c^{1.11}L^{0.8}A^{-0.57} ) (Sabol, 2008)</td>
</tr>
<tr>
<td>Agricultural</td>
<td>( T_c=7.2A^{0.2}L^{0.25}L_{ca}^{0.25}S^{0.2} ) (Sabol, 2008)</td>
<td>( R=0.37T_c^{1.11}L^{0.8}A^{-0.57} ) (Sabol, 2008)</td>
</tr>
<tr>
<td>Urban/developed</td>
<td>( T_c=3.2A^{0.1}L^{0.25}L_{ca}^{0.25}S^{0.14}RTIMP^{0.36} ) (Sabol, 2008)</td>
<td>( R=0.37T_c^{1.11}L^{0.8}A^{-0.57} ) (Sabol, 2008)</td>
</tr>
</tbody>
</table>

(1) These estimates should be used as a starting place; Tc and R should be checked and calibrated as needed based on reasonableness checks against peak flow envelopes and flood frequency estimates, as discussed in Sections 9 & 10 below.

(2) HEC-HMS’s Clark UH Variable method for estimating Tc and R may help in model calibration per Section 10 below.

Finally, several notes about the use of HEC-RAS 2D for rainfall-runoff transformation: No specific parameter guidelines are provided here because 2D modeling was not used in CSU’s mountain hydrology flood calibration studies. The CSU research showed that the unit hydrograph approach is generally adequate for modeling historical extreme floods in mountain basins. However, use of 2D runoff transform may be desired for basins with unique topography and may be helpful for modeling non-linear runoff response from extreme high-intensity rainfall, similar to HMSC’s Variable Clark UH method. Such non-linear response has been indicated by extreme floods along Colorado’s Front Range Foothills and Eastern Plains. Users should be aware that 2D diffusion wave runoff transformation may not be a physically accurate representation of runoff production in mountain basins, which are notable for their lack of surface flow (Larsen et al, 2009; Lin et al, 2008); therefore, 2D model parameters should be calibrated to observed floods. Also, RAS 2D does not currently perform rainfall loss calculations; excess precipitation would be calculated in another program, e.g. HEC-HMS. And sub-surface flow, considered to be an important component of mountain basin runoff production, would need to be added to a RAS 2D generated surface runoff hydrograph.

6.4 Linear Reservoir Baseflow method parameters are as follows: Reservoirs = 1, Initial Type = Discharge, GW1 Initial (cfs)=0, GW1 Fraction = blank, GW 1 Step is 1, and GW Coefficient = 3*R, where R is the Clark UH storage coefficient described above.

6.5 For Muskinghum-Cunge Reach Routing parameters, use reach properties calculated per Section 5.2 above using HEC-HMS Parameters->Characteristics -> Reach. Simple unit conversion may be needed. The user must determine reach cross-section geometry. Transects can be cut from DEM to help estimate channel shape.

6.6 Table 6 below summarizes all CSU-SMA method HEC-HMS parameters, estimation methods, and recommended values, where applicable:
### Table 6: CSU-SMA method HEC-HMS parameter list, estimation methods, & values

<table>
<thead>
<tr>
<th>HMS Method</th>
<th>Parameter (units)</th>
<th>Parameter estimation method</th>
<th>Recommended Parameter value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Meteorological Model</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Precipitation</td>
<td>Specified Hyetograph</td>
<td>See REPS Guidance document for creating REPS design storms and entering as HEC-HMS Time Series - Precipitation gages</td>
<td></td>
</tr>
<tr>
<td>Annual Evapotranspiration</td>
<td>Rate (in/day)</td>
<td>Use uniform 2-2.5 mm/day (0.079 - 0.098 in/day), per CSU research (Timilsina, 2021)</td>
<td>0.098 in/day</td>
</tr>
<tr>
<td><strong>Basin Model</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Simple Canopy</td>
<td>Initial Storage (%)</td>
<td>parsimony</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Max Storage (in)</td>
<td>Use uniform 4.3 mm (0.169 inch), average of north-facing &amp; south-facing slopes from Cache La Poudre site (Woolridge, 2019)</td>
<td>0.169 in</td>
</tr>
<tr>
<td>Uptake Method</td>
<td></td>
<td>Simple</td>
<td></td>
</tr>
<tr>
<td>Soil Moisture Accounting (SMA) Loss</td>
<td>Soil (%)</td>
<td>For design storms, base antecedent moisture condition (AMC) on seasonality of storm type. In general for extreme storms in CO, use field capacity (i.e. limit of gravity drainage)</td>
<td>Obtain from CSU-SMApython output <code>hms_initialsm_table</code> (use mean field) NOTE: CSU Python script assumes field capacity. User can edit code for AMC other than field capacity.</td>
</tr>
<tr>
<td></td>
<td>GW1 (%)</td>
<td>Parsimony</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>GW2 (%)</td>
<td>Parsimony</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Max Infiltration (in/hr)</td>
<td>Green &amp; Ampt infiltration rate using ½ Ksat and delta = 75mm (~3 in) (Woolridge, 2019)</td>
<td>Obtain from CSU-SMApython output <code>hms_maxinfil_table</code> (use mean field)</td>
</tr>
<tr>
<td></td>
<td>Impervious (%)</td>
<td>Uniform 5%, based on CSU calibrations/verifications, for undeveloped mountain basins. 5% as recommended starting place for mountain undeveloped basins. Use other methods where appropriate (ex. developed basins) and calibrate %impervious as needed per Sections 9 &amp; 10 below</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Soil Storage (in)</td>
<td>Allocate 85-95% of total soil water storage to soil storage, per CSU recommendation</td>
<td>Obtain from CSU-SMApython output <code>hms_soilstorage_table</code> (use mean field). CSU-SMA script is coded for 90% of available storage (10% to GW), user can adjust as needed</td>
</tr>
<tr>
<td></td>
<td>Tension Storage (in)</td>
<td>Soil water storage between field capacity and wilting point</td>
<td>Obtain from CSU-SMApython <code>hms_tensionstore_table</code> (use mean field)</td>
</tr>
<tr>
<td></td>
<td>Soil Percolation (in/hr)</td>
<td>Use ¼<em>Ksat, calculated by Saxton &amp; Rawls pedotransfer functions. CSU used ½</em>Ksat (Irvin, 2021). Colorado Dam Safety reduced to ¼*Ksat based on beta testing to reduce</td>
<td>Obtain from CSU-SMApython <code>hms_soilperc_table</code> (use mean field)</td>
</tr>
<tr>
<td>HMS Method</td>
<td>Parameter (units)</td>
<td>Parameter estimation method</td>
<td>Recommended Parameter value</td>
</tr>
<tr>
<td>------------</td>
<td>------------------</td>
<td>-----------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td></td>
<td>subsurface flow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GW 1 Storage (in)</td>
<td>Allocate 5-15% of total soil storage to GW1 layer, per CSU recommendation</td>
<td>Obtain from CSU-SMA python <code>hms_gw1storage_table</code> (use mean field). CSU-SMA script is coded for 10% of avail. Storage; user can adjust as needed</td>
<td></td>
</tr>
<tr>
<td>GW1 Percolation (in/hr)</td>
<td>Uniform try 2.5mm/hr (0.1 in/hr), based on CSU calibrations/verifications for Front Range basins; CSU used 0.5mm/hr for San Juan basins.</td>
<td>0.02 to 0.1 in/hr Calibrate as needed per Sections 9 &amp; 10 below, affects losses from system</td>
<td></td>
</tr>
<tr>
<td>GW1 Coefficient (hr)</td>
<td>Use 3 x Clark UH storage coefficient (i.e., 3xR)</td>
<td>3 x R (from Clark UH*) *Calculate in Clark UH parameters.xlsx spreadsheet. Calibrate as needed per Sections 9 &amp; 10 below</td>
<td></td>
</tr>
<tr>
<td>GW2 Storage (in)</td>
<td>Parsimony</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>GW2 Percolation (in/hr)</td>
<td>Parsimony</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>GW2 Coefficient (hr)</td>
<td>parsimony</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

Clark Unit Hydrograph Transform Method see Section 6.3 and Section 10 Standard or Variable

Time of Concentration, Tc (hr) Use Tc from Sabol (2008) for Rocky Mountain, Great Plains & Colorado Plateau or for Urban and Agricultural basins Ref: Sabol (1987) and Sabol (1993). See Table 5 above Calculate in Clark UH parameters.xlsx spreadsheet, using sub-basin characteristics from HEC-HMS (parameters->characteristics->sub-basin)

Storage Coefficient, R (hr) Use R/(Tc+R) ratio method or R from Sabol (2008) - see Table 5 above See Table 5 above Calculate in Clark UH parameters.xlsx spreadsheet, using sub-basin characteristics from HEC-HMS (parameters->characteristics->sub-basin)

Time-area Method Use default HEC-HMS default

Linear Reservoir Baseflow Reservoirs (#) 1

Initial Type Discharge

GW1 Initial (cfs) 0

GW1 Fraction Blank

GW Coefficient Use 3 x Clark UH storage coefficient (i.e., 3xR) 3 x R (from Clark UH*) *Calculate in Clark UH parameters.xlsx spreadsheet. Calibrate as needed per Sections 9 & 10 below

GW1 Steps 1

Muskingum-Cunge Length (ft), Slope from HEC-HMS Parameters
<table>
<thead>
<tr>
<th>HMS Method</th>
<th>Parameter (units)</th>
<th>Parameter estimation method</th>
<th>Recommended Parameter value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reach Routing</td>
<td>(ft/ft)</td>
<td>menu-&gt;Characteristics-&gt;Reach</td>
<td></td>
</tr>
<tr>
<td>Initial Type</td>
<td></td>
<td>Discharge = Inflow</td>
<td></td>
</tr>
<tr>
<td>Mannings n</td>
<td>Use literature values</td>
<td>Generally 0.03 - 0.07 for mountain streams</td>
<td></td>
</tr>
<tr>
<td>Index Method</td>
<td></td>
<td>Flow</td>
<td></td>
</tr>
<tr>
<td>Index Flow (cfs)</td>
<td>Use Q-2yr (50% AEP) estimate from StreamStats or other bankfull flow estimate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shape</td>
<td>Trapezoid or 8-point, etc., depending on channel and available data. Transects from DEM may help determine channel/floodplain shape</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6.7 **Parameter Estimation Reporting Requirements:** Engineers should provide the following documentation (See example reporting in Appendix A):

- Summary table of all parameter estimates listed in Table 6 above, by sub-basin (link to sample spreadsheet)
- Print CSU_SMApython output tables for review in order to cross-check against HEC-HMS model input: hms_initialsm_table, hms_maxinfil_table, hms_soilstorage_table, hms_tensionstore_table, hms_soilperc_table, hms_gw1storage_table.
- Print the completed Clark UH parameters.xlsx spreadsheet

6.8 Parameter estimates should be reviewed for reasonableness based on sub-basin properties (from Section 5), NRCS Web Soil Survey, published parameter values, and based on basin characteristics and region of study. Table 7 below provides a summary of Green & Ampt parameters -- porosity, wetting front suction head, and saturated hydraulic conductivity -- by soil texture (Chow, 1988) for cursory checks of CSU_SMApython output. For example, a back of envelope check can be made where soil storage should be roughly equal to porosity for predominate soil texture in each sub-basin multiplied by its average depth to restrictive layer. Likewise, Clark UH and reach routing parameters can be checked against USGS StreamStats basin characteristics.

Table 7: Green & Ampt infiltration parameters by soil classification (Chow, 1988) – provided ONLY for rough check of CSU_SMApython output

<table>
<thead>
<tr>
<th>Soil classification</th>
<th>Porosity, n</th>
<th>Wetting front suction head, psif (inch)</th>
<th>Hydraulic conductivity, K (inches/hour)</th>
</tr>
</thead>
<tbody>
<tr>
<td>sand</td>
<td>0.437</td>
<td>1.9</td>
<td>4.64</td>
</tr>
<tr>
<td>loamy sand</td>
<td>0.437</td>
<td>2.4</td>
<td>1.18</td>
</tr>
<tr>
<td>sandy loam</td>
<td>0.453</td>
<td>4.3</td>
<td>0.43</td>
</tr>
<tr>
<td>loamy sand</td>
<td>0.463</td>
<td>3.5</td>
<td>0.13</td>
</tr>
<tr>
<td>silt loam</td>
<td>0.501</td>
<td>6.6</td>
<td>0.26</td>
</tr>
<tr>
<td>sandy clay loam</td>
<td>0.398</td>
<td>8.6</td>
<td>0.06</td>
</tr>
<tr>
<td>clay loam</td>
<td>0.464</td>
<td>8.2</td>
<td>0.04</td>
</tr>
<tr>
<td>silt clay loam</td>
<td>0.471</td>
<td>10.7</td>
<td>0.04</td>
</tr>
<tr>
<td>sandy clay</td>
<td>0.43</td>
<td>9.4</td>
<td>0.02</td>
</tr>
<tr>
<td>silty clay</td>
<td>0.479</td>
<td>11.5</td>
<td>0.02</td>
</tr>
<tr>
<td>clay loam</td>
<td>0.475</td>
<td>12.5</td>
<td>0.01</td>
</tr>
</tbody>
</table>
Section 7. **HEC-HMS Model Setup**

7.1 In HEC-HMS a new project with a basin model and terrain data should be created (described in Section 5.2 above for purposes of sub-basin delineation and determining sub-basin and reach properties). See Figure 8 below.

![Figure 8: Example basin model and terrain setup in HEC-HMS](image)

7.2 At this point all necessary model parameters have been generated and can be entered into the HEC-HMS model. REPS temporal patterns for input to HMS were discussed in Sections 4 and 5 above. SMA loss method, Clark UH, Linear Reservoir Baseflow, and Reach Routing parameters have been estimated per Section 6. The user’s parameter estimation summary table (see Section 6.6 and Table 6 above) can serve as an easy reference for HEC-HMS model parameter input. If partial area analysis is being done, then the partial area analysis summary table generated in Section 5.4.3 above will be useful for model setup.

7.3 Precipitation Gage Time Series:

7.3.1 For REPS design storms, the recommendation is to create a Precipitation Gage Time Series for each REPS storm (a zero-rain precipitation gage can be created to facilitate partial area analysis). Time series should be input in cumulative inches. Table 8 shows the time interval for each REPS design storm temporal distribution.

<table>
<thead>
<tr>
<th>Design Storm Description</th>
<th>Temporal Distribution Time Interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>REPS PMP 2-hr, 6-hr and 24-hr Local Storms</td>
<td>5 minutes</td>
</tr>
<tr>
<td>REPS PMP 72-hr GS and TS</td>
<td>15 minutes</td>
</tr>
<tr>
<td>REPS PF LS</td>
<td>5 minutes</td>
</tr>
<tr>
<td>REPS PF MEC</td>
<td>5 minutes</td>
</tr>
<tr>
<td>REPS PF MLC</td>
<td>1 hour</td>
</tr>
</tbody>
</table>
7.3.2 Storm Durations: The recommendation for the CSU-SMA model method is to run all 2-hr through 24-hr design storms for minimum 2-day simulation duration and run all 48-hr & 72-hr duration design storms for minimum of 10-day simulation duration in order to ensure the full recession limb volume of the hydrograph is modeled, including subsurface flow. At the end of the simulation, discharge should be equal or less than 5% of peak flow. Cumulative precipitation gage time series data must be extended to these same durations. Table 9 shows recommended simulation durations (and thereby precipitation time-series durations) by REPS storm type.

<table>
<thead>
<tr>
<th>Design Storm</th>
<th>Recommended Simulation/Time-series Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>REPS PMP 2-hr, 6-hr and 24-hr Local Storms</td>
<td>2 days (2880 minutes)</td>
</tr>
<tr>
<td>REPS PMP 72-hr GS and TS</td>
<td>10 days (240 hours or 14,400 minutes)</td>
</tr>
<tr>
<td>REPS PF LS</td>
<td>2 days</td>
</tr>
<tr>
<td>REPS PF MEC</td>
<td>2 days</td>
</tr>
<tr>
<td>REPS PF MLC</td>
<td>10 days</td>
</tr>
</tbody>
</table>

NOTE: At the end of the simulation, discharge should be equal or less than 5% of peak flow.

7.3.3 REPS temporal distribution time series can be copied and pasted from REPS temporal distribution output text files into the HEC-HMS precipitation gage time series. Tip: REPS MetPortal v2.2.0 allows the user to download precip frequency storm temporal patterns scaled to all AEPs at once, by storm type. The user must manually check the “Download data for all AEPs?” box at the top center of the Temporal Patterns page.

A REPS temporal pattern spreadsheet tool to extend all PF and PMP distributions to the recommend time-series durations per Table 9 above can be downloaded from the following Google Drive link: https://docs.google.com/spreadsheets/d/1HCPFrPRnbK3lt7TuO61BkPR6NaPb8DGR/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true

Tip: For efficiency, in HEC-HMS a single precipitation gage can be created for each time increment/duration combination per Tables 8 and 9 above (e.g. 5-minute time interval, 2 day duration), then this “template” can be copied in HEC-HMS for each applicable REPS design storm (e.g. REPS 10e-1 thru 10e-7 AEP LS and MEC and REPS 2hr, 6hr, and 24hr LS PMP); then each REPS temporal distribution from the temporal pattern spreadsheet can be copied and pasted into HEC-HMS.

Figures 9 and 10 below show example precipitation gage setup in HEC-HMS.
7.4  Meteorological Model Setup: A meteorological model should be created for each REPS design storm.

*Tip: For efficiency, the recommendation here, based on HEC-HMS 4.7, is to create the first meteorological model and setup annual evaporation. This Met Model can then be copied for other storm types. Also, if partial area analysis is being done, then it may be helpful to setup each partial area Met Model “template” that can then be copied and edited for other design storms that use the same partial area.*

7.4.1  Evaporation: Enter annual evaporation rate (0.098 in/hr, see Table 6 above) for all sub-basins. Figure 11 shows an example evaporation element setup.
7.4.2 Specified Hyetographs: Next create a Specified Hyetograph for each REPS design storm Met Model, which may be for up to 26 storms, depending on the basin location (2hr LS PMP, 6hr LS PMP, 24hr LS PMP, 72hr GS PMP, 72hr TS PMP, and 10e-1 through 10e-7 AEP for LS, MEC and MLC PF storm types). Figure 12 shows an example of the recommended Met Model setup for all REPS design storms. Figure 13 shows an example Met Model Specified Hyetograph setup for partial area analysis (note the use of a zero precipitation rain gage for sub-basins outside of the partial area).

NOTE: Alternatively, instead of creating a unique Precipitation Gage Time Series and Met Model for each of the 21 REPS Precipitation Frequency storms, a single Met Model could be created for each storm type using its REPS MetPortal unscaled temporal pattern. Then it can be scaled by the PF best estimate per AEP in each HEC-HMS simulation run. This “simulation scaling” approach may save time during model setup, but tends to be more difficult in terms of model analysis and documentation.

Lastly, using the recommended approach of creating a Met Model for each REPS storm, then the HEC-HMS simulation precip scaling can be used for the required 1.07 atmospheric moisture factor from State Dam Safety Rule 7.2 (see Section 10.2 below for more discussion on how to use the AMF).
7.5 Basin Model Setup:

7.5.1 Sub-basin elements. Each sub-basin element in the HEC-HMS model should be set to the following methods: Canopy method = Simple Canopy, Loss Method = Soil Moisture Accounting, Transform method= Clark Unit Hydrograph, and Baseflow Method= Linear Reservoir (see Figure 14 below) *(Tip: These can be set as defaults in HEC-HMS under Tools->Program Settings->Defaults)*. The user’s parameter estimation table (see Section 6.6 and Table 6 above) will facilitate easy parameter input. Figures 15-18 below show example parameter inputs for each method.
7.6 HEC-HMS Control Specs: Table 9 above showed recommended simulation durations in order to ensure hydrograph recession limb and volumes are simulated completely, including subsurface.
flow from the SMA method. In general two control specifications should be sufficient: General Storms (10-day duration) and Local Storms (2-day duration). The recommended simulation time interval is 5 minutes for General Storms and 1 minute for Local Storms.

7.7 **Quality Control Check:** There is a large amount of HEC-HMS model input data between the CSU-SMA method and REPS design storms. The model should be thoroughly QC checked by the user. Sub-basin property summary tables (Section 5 above) and parameter summary tables (Section 6) will facilitate QC checking. HEC-HMS Standard Reports can also be helpful for efficiently checking all model elements. As the REPS rainfall inputs require numerous steps and manipulations, please check precipitation amounts, time intervals, applied sub-basins (for partial area analysis), etc. in HEC-HMS Precip Gages and Met Models.
Section 8. **HEC-HMS Output and Report Documentation**

8.1 In HEC-HMS a simulation run for each REPS design storm should be executed (in the Compute tab) using the correct basin model, meteorological model, control specifications, and precipitation ratio (if applicable). **Tip:** HEC-HMS allows multiple simulation runs simultaneously (under Compute->Multiple Compute), which can be helpful with up to 26 REPS design storms.

8.2 HEC-HMS output for hydrology reporting should generally follow model calibration (see Section 10). The following output should be included (See example reporting in Appendix A):

8.2.1 In HEC-HMS, print a summary report under Tools->Reports->Standard Reports. Due to the large number of REPS storms and large size of the Standard Reports, the recommendation is to print only the Standard Report for REPS inflow design flood (IDF) for design flood studies, or in the case of hydrologic risk study (where there is no design flood), print the dam overtopping (or other relevant hydrologic failure mode) REPS precipitation frequency event. The following output options should be selected for the Standard Report (see Figure 19 below): Global Parameter Summary Tables -- Sub-basin, reach; Element Parameter Summary Tables -- Subbasin, Sink; Element Time Series Graphs -- Baseflow, Cumulative Precipitation, Cumulative Precipitation Loss, Direct Runoff, Precipitation Loss, Saturation Fraction, Soil Infiltration, and Soil Storage.

![Figure 19: Recommended output options for HEC-HMS Standard Report](image-url)
8.2.2 Using HEC-DSSVue or other graphing software, the following reservoir inflow hydrographs should be generated and included in the hydrology report:

- All AEPs and PMP reservoir inflow hydrographs overlaid on a single graph for each REPS storm type
- 10e-4 AEP reservoir inflow hydrographs for all storm types (LS, MEC, MLC)
- PMF inflow hydrograph for all storm types (2hr LS, 6hr LS, 24hr LS, 72hr GS and 72 TS)

8.2.3 Modeled peak flow frequency curves (reservoir inflows) should be plotted for all REPS precipitation frequency storms, along with flood frequency curves from USGS StreamStats estimates and regional stream gage flood frequency analyses (see Sections 9 & 10 for more details). Modeled REPS PMF peak flows should be overlaid as horizontal lines. A spreadsheet for presentation of peak flow frequency curves is provided at the following Colorado Dam Safety Google Drive link:

https://docs.google.com/spreadsheets/d/1e53m0RrJTF-N5N3zOxhbfMDzaaLGo/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true

An example plot is shown in Figure 20 below.

![Figure 20: Example flood frequency curves plot comparing modeled REPS AEP and PMF storms to USGS StreamStats and stream gage flood frequency curves.](image)
8.2.4 Reservoir inflow, reservoir stage, and reservoir outflow hydrographs from HEC-HMS should be plotted.

8.2.5 For hydrologic risk evaluation of existing dams, reservoir stage probability curves should be plotted for all REPS precipitation frequency storms. REPS PMF peak reservoir stages should be overlaid (as horizontal lines) along with pertinent dam features (e.g. spillway crest, dam crest). The flood frequency curve spreadsheet (see Section 8.2.3 above) includes a worksheet for graphing reservoir stage probability curves. An example plot is shown in Figure 21 below. Other probability curves may be required depending on credible potential failure modes (e.g. spillway unit discharge probability curves for spillway erosion PFM).

8.3 HEC-HMS results should be reviewed by the Engineer for the following:

- Calculate and tabulate the runoff coefficient for each design storm, which can be calculated as runoff volume divided by rainfall volume. CSU found runoff coefficients averaged around 30% for the historical extreme storms around 100-YR ARI magnitude. Runoff coefficient values generally increase with high rainfall intensities (relative to basin soil infiltration capacities), higher initial soil moistures, and with larger precipitation volumes (Niemann and Eltahir, 2004). For example, Colorado Dam Safety has found that runoff coefficients may be as high as 80-90% for Local Storm PMF.

- Compare baseflow and direct runoff hydrographs to determine which is dominant. Also compare timing of baseflow and direct runoff peaks and the total hydrograph. They should generally combine to form a steady rising limb, single peak, and then steady
recession limb, based on CSU’s review of observed flood hydrographs in Colorado mountain basins.

• Review saturation fraction for larger volume design storm events. Saturation fraction of 85% and above is assumed to cause saturation excess runoff (Woolridge, 2019). Saturation-excess runoff may be indicated when the direct runoff hydrograph peak aligns with the soil saturation fraction peak (see HEC-HMS Standard Report). Below 85%, surface runoff is considered to be infiltration-excess, in which case the direct runoff peak is expected to align closely with maximum rainfall intensity. Saturation-excess verses infiltration-excess runoff mechanisms should be reviewed for reasonableness based on basin properties, storm type, storm AEP/magnitude, etc. In general, short-duration intense thunderstorms are expected to result in lower saturated fractions and infiltration-excess runoff. Longer duration, larger magnitude storms may result in saturation fractions above 85% and saturation-excess runoff, depending on soil properties and soil water storage volume. Saturation-excess runoff may result where soil storage volume is low and infiltration rates are high (i.e. thin, coarse-grained soils) or conversely for fine-grained soils where infiltration rates may be low but tension storage and initial soil moisture are relatively high.
Section 9. **Reasonableness Checks & Confidence**

9.1 Extreme flood estimates for dam safety evaluation and design in Colorado traditionally have been determined by extrapolation of uncalibrated rainfall-runoff models, often yielding, in the mountains and Western Slope, flood estimates several orders of magnitude larger than the largest observed floods. However, Robert Jarrett (USGS) and others have cited a lack of paleoflood and historical evidence for such extreme floods in Colorado’s Rocky Mountains.


> Over the past several decades, historical data and information have been shown to be extremely valuable in flood frequency analysis (Leese, 1973; Condie and Lee, 1982; Stedinger and Cohn, 1986, 1987; Cohn and others, 1997; England and others, 2003a). Dalrymple (1960) notes the following: “Historical floods provide probably the most effective data available on which to base flood frequency determinations, and where the data are reliable, this information should be given the greatest weight in constructing the flood frequency graph.” Historical flood information should be obtained and documented whenever possible. Use of historical data assures that estimates fit community experience and improves the frequency determinations. This information is valuable in flood frequency analysis because it directly contributes extreme flood data on low annual-exceedance probability floods.

Further, Waltemeyer (2008), talking about regional envelopes of observed flood peaks, said they can “serve as a guide to the reasonableness of flood frequency estimates for large recurrence intervals.”

As stated in Section 1 above; uncalibrated rainfall-runoff model results, per Sections 4 through 8 above, are viewed here only as a starting point, and “reasonableness” (i.e., accuracy) of such results should not be assumed. Checking and calibrating model results against the historical flood record is considered to be an integral step in these guidelines. Only after these checks are done do we consider the model to provide a best-estimate of flooding. At the same time, confidence (i.e., precision) is built through the reasonableness checks process. Some dams and basins may have a large amount of historical flood information, which makes a case for strong confidence in calibrated model results. Other basins may have very little flood information and may rely on regional data sets. Regardless, we have found that the process of gathering available historical flood information yields more defensible hydrology results.

Engineers should use multiple lines of evidence to make the case for reasonable design floods -- using gaged floods, indirect flood measurements, anecdotal flood records, and paleoflood studies. Regional flood frequency methods, like USGS StreamStats, can be used as well as regional stream gage flood frequency analysis by USGS Bulletin 17C (England et al, 2019). Historical floods can be researched using SEO Dam Safety files, newspaper archives, Colorado State University's *Extreme Storm Precipitation Data Study, #97-1* (McKee and Doesken, 1997), the USGS Colorado Flood Database, etc. These data can be plotted on regional peak flow envelope curves, along with plotting modeled REPS probabilistic and REPS PMF peak flows, and on flood frequency curve plots comparing simulated REPS flood frequency curves with StreamStats and 17C stream gage flood frequency curves. The reasonableness checks discussed in this section tend to emphasize discharge, not runoff volume. Peak flow is generally considered to be more difficult to model correctly. Volume is thought to follow from simulating the correct controlling REPS storm type(s), which is addressed by several of the reasonableness checks below.
The following sub-sections provide guidance on specific reasonableness checks (see Appendix A for Example Reasonableness Checks summary reports and Appendix C for a Reasonableness Checks template):

9.2 Stream Gage Flood Frequency Analysis: Many stream gages are or have been operated in Colorado, by the USGS, DWR, Denver Metropolitan Flood District, and others. If the basin of interest is gaged with an adequate period of record, then flood frequency analysis should be performed and plotted in comparison to modeled REPS design storm flood frequency curves, assuming AEP neutrality, i.e., the simplifying, but useful, assumption that a given AEP rainfall event produces the same AEP flood peak. 10-YR, 100-YR and 1000-YR flood frequency estimates can be estimated using USGS Bulletin 17C (England et al, 2019) methods and then compared to modeled REPS probabilistic design storms. Flood frequency estimates beyond 1000-YR may be possible if paleo-flood estimates are available. The USGS PeakFQ and USACE HEC-SSP computer programs are helpful for flood frequency analysis.

If the basin or site of interest is ungaged, then flood frequency analysis can be performed on stream gages on hydrologically similar locations in close proximity, if possible. Stream gage data can be transpositioned from one gage to another using area scaling procedures. For example, Vaill (USGS, 2000) suggests the following scaling relationship where the drainage area ratio is between 0.5 and 1.5 and the basins have similar land and climate characteristics:

$$Q_{T(u)} = Q_{T(g)} \left(\frac{A_u}{A_g}\right)^x$$

where, $Q_{T(u)}$ is the estimated flood frequency discharge (cfs) at ungaged site for T-year ARI $Q_{T(g)}$ is the flood frequency peak discharge at the gaged site for T-year ARI $A_u$ is the drainage area in square miles at ungaged site $A_g$ is the drainage area in square miles at gage $x$ is the average exponent for drainage area, by region: Mountains=0.69, Rio Grande 0.88, Southwest=0.71, Northwest=0.64, and Plains=0.40.

See Vaill (USGS, 2000) for regional maps and additional guidance on use of the above scaling relationship.

Alternatively, regional stream gages for multiple basin sizes can be used to define a regional 100-YR peak flow curve on a peak flow vs. drainage area graph, which then can be compared to REPS 10e-2 AEP model results for the basin-of-interest. In general, modeled AEP peak flows should be reasonably close (+/-20%) to corresponding AEP flood frequency estimates.

9.3 Regional Regression Flood Frequency Methods: In conjunction with stream gage data, USGS StreamStats peak flow estimates should be determined for the basin-of-interest: https://streamstats.usgs.gov/ss/

StreamStats provides regression-based flood frequency estimates, typically for 2-YR through 500-YR ARI. Generally StreamStats frequency curves can be extrapolated to 1000-YR ARI for our purposes and then compared to REPS probabilistic design storm simulations. Again, modeled REPS AEP peak flows should be reasonably close to corresponding ARI StreamStats peak flow estimates (within StreamStats standard errors of prediction). If a basin is gaged, then comparison to the 17C flood frequency analysis should be given more importance than StreamStats.

9.4 Review of Historical and Paleo-Floods: Much can be learned by investigating historical floods in the basin or region of interest. Newspaper archives and local historical societies are often good sources. Colorado Dam Safety files often have records of noteworthy floods at existing dams. Many dams in Colorado are 100-years old or older, providing a good record of historical flooding. Colorado State University’s Extreme Storm Precipitation Data Study, #97-1
(McKee and Doesken, 1997), the USGS Colorado Flood Database, and REPS Summary Report Volume II provide good inventories of historical floods (DWR Google drive link to historical flood documents). Reservoir stage probability curves (see Section 8.2.5 above) should be checked for consistency with the historical record at existing dams, in terms of controlling storm/flood types, record stage, frequency of spillway activation, past dam overtopping incidents, etc.

Paleo-flood studies, as a sub-set of historical floods, are particularly useful in providing upper limits of the largest floods that have occurred in a river in long time spans (Jarrett and Tomlinson, 2000). Paleo-flood studies use physical evidence to provide valuable information about historical or ancient flooding at a site. The information can be non-exceedance thresholds or maximum flood stages. Paleo-flood indicators can include gravel bars, terraces, high water marks, flood scarring, etc. Dating methods include dendrochronology, radio-carbon, or relative dating techniques. Site-specific paleo-flood studies will only be feasible for the most advanced hydrology studies on large, complex projects. Fortunately, many existing regional paleo-flood studies are available in Colorado by the USGS, USBR, USACE and others, in scientific literature. The USGS Colorado Flood Database (discussed in detail below) contains paleo-discharge estimates and links to studies by USGS.

9.5 Event Calibration: For more advanced studies flood reconstruction modeling of historical storms/floods can be performed. For historical storms used in the REPS PMP study (see REPS Summary Report Vol. II, Table 2, for a list of storms) Colorado Dam Safety may have access to hourly rainfall raster data for event calibration. Other historical storms (i.e. not used in REPS) that occurred in a basin-of-interest can often be reconstructed by consulting meteorologists. The sources listed in Section 9.4 above may be useful for identifying historical storms/floods in a base-of-interest for event calibration. USGS, DWR, and other stream gage data sets can be reviewed to determine whether historical flood hydrograph data are available.

9.6 Controlling Storm Type: Modeled controlling REPS storm type(s) should be compared to the storm/flood type(s) of historical flooding for the basin or region of interest. The flood frequency curve and reservoir stage probability curve plots (see Sections 8.2.3 and 8.2.5 above) depict modeled controlling REPS storms type(s) over the range of AEP and PMP magnitudes. Information on storm types of observed, historical floods can be discerned from flood reports/files, date/season of occurrence, flood duration, and stream gage hydrographs.

The following general guidance on controlling storm type by drainage area size can be checked against model results (email from M. Schaefer, 3/15/2020):

- As a rough guideline, a “very-small” watershed can be considered to have a drainage area of less than about 5-square miles where high-intensity, short-duration very localized convective storms (Local Storm, LS) can produce rare to extreme floods with very high unit discharges (500 cfs to 10,000-cfs per sqmi, depending on the region)
- A “small” watershed can be considered to have a drainage area of less than about 20-square miles where convective storms (LS) and Mesoscale Storms with Embedded Convection (MEC) produce rare to extreme floods
- An “intermediate” size watershed for Colorado can be considered to have a drainage area of between 20 and about 250-square miles where MEC storms can produce rare to extreme floods
- A “large” size watershed for Colorado can be considered to have a drainage area greater than about 250 square miles where synoptic scale Mid-latitude cyclones (MLC) produce rare to extreme floods
- Note that in the REPS MetPortal Western Macro Region, MEC storms are uncommon. Control may pass from LS to MLC without intermediate MEC storm control.

9.7 Seasonality of Controlling Storms/Floods: In Colorado, there are strong seasonal aspects to rainfall, storm types, and flooding, and these vary by region. Historical flood and stream gage
peak flow records provide information about the seasonality of flooding in a basin or region of interest. CO-NM REPS analyzed seasonality of the largest 50 historical storms of each storm type (LS, MEC & MLC) in each of the regions shown below in Figure 22 (northwest, northeast, southwest, and Rio Grande); Figures 23, 24, and 25 below show histograms of the resulting seasonal distributions of the largest LS, MEC, and MLC storms, respectively, by region (from REPS Summary Report, Vol. III, 2018). Further, REPS Vol. II (PMP), Appendix F, provides the time of year for historical extreme storms used for REPS PMP.

As a reasonableness check of rainfall-runoff model results, the seasonality of the controlling REPS storm type(s) (i.e. using model results and Figures 23, 24 & 25) should be checked against the seasonality of historical flooding for the basin/region of interest. This seasonality check may help to verify that the model is producing the correct controlling REPS storm type, where the actual storm type of historic floods may not be known to the engineer, but the time of year is known. For example, suppose your model for a basin in the Rio Grande region finds the controlling REPS storm type is the MLC, which is most likely to occur in September by the last histogram in Figure 25. Looking at regional stream gages, you find that historical peak flows for the region typically occur in August or September, consistent with model results.

Figure 22: Regions for CO-NM REPS storm seasonality analysis.
Figure 23 (cont’d on next page): Seasonal distribution of largest 50 Local Storms in each region. Top histogram is for north-west region, bottom is for north-east region (cf: Figure 22). (REPS Vol. III, 2018)
Figure 23 (cont’d from previous page): Seasonal distribution of largest 50 Local Storms in each region. Top histogram is for south-west region, bottom is for Rio Grande region (cf: Figure 22) (REPS Vol. III, 2018)
Figure 24 (cont’d on next page): Seasonal distribution of largest 50 Meso-scale with Embedded Convection (MEC) storms in each region. Top histogram is for north-west region, bottom is for north-east region (cf: Figure 22) (REPS Vol. III, 2018)
Figure 24 (cont’d from previous page): Seasonal distribution of largest 50 Meso-scale with Embedded Convection (MEC) storms in each region. Top histogram is for south-west region, bottom is for Rio Grande region (cf: Figure 22) (REPS Vol. III, 2018)
Figure 25 (cont’d on next page): Seasonal distribution of largest 50 Mid-Latitude Cyclone (MLC) storms in each region. Top histogram is for north-west region, bottom is for north-east region (cf: Figure 22) (REPS Vol. III, 2018)
Figure 25 (cont’d from previous page): Seasonal distribution of largest 50 Mid-Latitude Cyclone storms in each region. Top histogram is for south-west region, bottom is for Rio Grande region (cf: Figure 22) (REPS Vol. III, 2018)
9.8 **Regional Peak Flow Envelope Curves & USGS Colorado Flood Database:**

9.8.1 Modeled peak flows can be plotted on regional peak flow envelopes as a reasonableness check against maximum observed flood discharges. Peak flow envelopes typically plot observed maximum floods - gaged, indirect (surveyed after-the-fact), and paleo-flood estimates - as a function of drainage area; the plots are typically shown in log-log space due to large non-linearities. Peak flow envelopes have been widely used in hydrology literature to examine possible upper limits of flooding and regional variations in flood production (Crippen and Bue, 1977; Wolman and Costa, 1982; Costa, 1987; and O'Connor and Costa, 2004). Crippen and Bue divided the continental U.S. into 17 regions based on variations in physiography and rainfall intensity; Regions 12-14 cover Colorado. They then plotted peak flow measurements from gaged and indirect discharge measurements from 883 locations and defined regional peak flow envelope curves. O'Connor and Costa (2004) used a USGS database of 35,663 annual peak flows at 14,815 U.S. stream gage stations and plotted peak flow envelopes for 90th percentile and 99th percentile peak flows. They then mapped the 90th and 99th percentile flow locations to show regions that are prone to extreme flooding. They concluded such regions have access to atmospheric moisture and have topographic relief, causing orographic forcing of rainfall and rapid concentration of streamflow. U.S. 90th percentile peak flows have occurred along Colorado’s Front Range Foothills, along the Colorado-New Mexico border south of the Raton Mesa, and in the Republican River basin on Colorado’s eastern plains.

Envelope curves have often been used to guide engineering design (Wolman and Costa, 1982). Wolman and Costa say that envelope curves provide a useful check on peak flow estimates, but should not be relied on solely for engineering design because of basin-specific variations. While the curves capture large regional differences based on climate and terrain, they do not address basin-scale variations like micro-climates, soil variations, basin slope, etc. Wolman and Costa also showed that new peak flows are increasing the U.S. peak flow envelope more slowly as time goes by and the dataset of peak flows increases. They suggested at that time (1982) that the envelope may be approaching a physical limit. Although Crippen and Hue (1977) stated there is no statistical return interval associated with peak flow envelopes, an upper physical limit is suggestive of the probable maximum flood. Vogel et al (2007) demonstrated possible statistical methods to estimate exceedance probability of a flood of record (FOR) envelope using 226 USGS stream gages in the continental U.S. and for an envelope of associated PMF estimates (by Nuclear Regulatory Commission) at those same locations. For their dataset, they estimated exceedance probabilities between 10e-4 and 10e-6 for the FOR envelope and about 10e-6 to 10e-8 for the PMF envelope.

The U.S. Bureau of Reclamation uses regional peak flow envelope curves as part of hydrologic risk analysis. Regional envelope curves capture important regional differences in flood production across Colorado. The USBR’s regional peak flow envelope used for Colorado’s Front Range (USBR, 2009) is significantly higher than that used for the Rocky Mountain inter-mountain region (USBR, 2008). For example, at 100 square mile drainage area size, the USBR’s Front Range envelope peak flow is about 40,000 cfs versus about 6,000 cfs for the inter-mountain region envelope (NOTE: these particularly 2008 and 2009 envelopes are based only on gaged peak flows, not indirect or paleo-floods). Alberta, Canada’s Ministry of Transportation (undated) plotted gaged and estimated peak flows for six basins on the eastern slopes of the Canadian Rocky Mountains, and evaluated several methods of enveloping them. They concluded that Creager envelopes (Creager et al, 1950) did not perform well over the full range of area sizes (10 sqkm to about 100,000 sqkm), but visually drawn envelopes provided a better fit of the data over the range of area sizes. They caution that envelope curves provide context for an upper range of flows, but that basin runoff is a function of many properties besides drainage area.
9.8.2 Colorado Dam Safety has used the USGS’s Colorado Flood Database (created in cooperation with Colorado Department of Transportation) to develop regional peak flow envelopes for Colorado, for the purpose of reasonableness checks of extreme flood rainfall-runoff models for dam safety purposes. Note that in keeping with Crippen and Bue, Alberta Ministry of Transportation, and others, Colorado Dam Safety’s envelope curves are visually fit to the observed flood data.

The USGS describes the importance of using historical, systematically collected flood data. The purpose of the Colorado Flood Database is to make systematic flood records available to water resources engineers to improve flood estimates (Kohn et al, 2013). The Colorado Flood Database includes gaged peak flows and indirect-measured peak flows from 1867 - 2015. The database includes flood peaks from many of the same extreme storms that were used to develop REPS PMP, e.g., June 1921 on the Arkansas River, May 1935 Cherry Creek, June 1965 Jimmy Camp Creek, etc. Gaged peaks occurred at USGS stream gage locations in the NWIS database; indirect measurements are from flood studies either at sites with no stream gage or outside of the gaged period of record. The database also includes peak flow estimates from paleo-flood studies. The database includes 6,886 flood events at 1,624 sites in Colorado (see Figure 26). The Colorado Flood Database web address is:


Figure 26: General distribution of the 1,624 flood sites included in the USGS Colorado Flood Database (https://cwscpublic2.cr.usgs.gov/projects/coflood/COFloodMap.html)

9.8.3 Colorado Dam Safety mapped the Colorado Flood Database dataset and experimented with regional groupings that showed similar peak flow limits in terms of maximum observed peak flows versus drainage area size. Three regions were determined using REPS storm transposition zones (Figures 27 & 28): (1) Eastern Plains/Front Range Foothills < 7,500 feet elevation (REPS transposition zones 1 and 3), (2) Mountains >7,500 feet elevation (REPS transposition zones 5, 6 and 9), and (3) Western Colorado < 7,500 feet elevation (REPS transposition zones 10, 14, 15, and 16). Following is a discussion of each regional curve:
Figure 27: REPS PMP storm transposition zones (red) overlaid on terrain.

Figure 28: Colorado Dam Safety peak flow envelope regions: (1) Eastern plains and Front Range foothills < 7500 feet elevation (blue), (2) Mountains > 7500 feet elevation (brown), and (3) Western Colorado < 7500 feet (pink) with REPS PMP storm transposition regions outlined and numbered in red.
9.8.3.1 Eastern Plains/Front Range Foothills < 7500 feet elevation Peak Flow Envelope (Figure 29): This peak flow envelope is by far the most extreme of the three Colorado curves. It covers the highly dynamic weather region that can see high moisture influx from the Gulf of Mexico and has steep orographic terrain along the Front Range foothills, creating orographic lift and rapid runoff response. This envelope curve is controlled by several of the worst floods in Colorado’s recorded history: June 1965 on Kiowa Creek, Plum Creek and Jimmy Camp Creek (one of the highest peak flows for its drainage area size in the U.S.); April 1935 on Kiowa Creek; and July 1976 on the Big Thompson River. In terms of controlling Storm Types versus area size, the July 1976 Big Thompson storm, which generally controls the envelope at area size less than five square miles, is classified by REPS as a Local thunderstorm (REPS Summary Report, Vol. II, App. F). The July 1965 and May 1935 storms control the envelope above 50 square miles. REPS PMP classifies both of these storms as Local/Hybrid storms (i.e., Meso-scale with Embedded Convection); both were large area events, but included smaller cells of embedded convection and high intensity rainfall. It is worth noting that historical long-duration, low intensity PMP General Storms along the Front Range Foothills (e.g. Sept. 2013 and 1969 Big Elk Meadows) do not control the flood envelope.

USGS paleoflood estimates are included in the Colorado Flood Database, but do not control the Eastern Plains/Front Range Foothills envelope. Several dam failure peak flows in the database were ignored for purposes of drawing our peak flow envelope; the dam breach peak flows stand out as outliers relative to natural floods. Crippen and Bue’s eastern region (their Region 12) envelope (green dashed curve on Figure 29) matches Colorado Dam Safety’s Eastern Plains/Foothills envelope well. This is encouraging, meaning the envelope has not changed significantly since 1977. As noted above, Colorado Dam Safety’s envelope (red line in Figure 29) is visually fit to the data and should be considered only as a guide. Finally, observed peak flow data have been sub-divided by REPS transposition zone and plotted in different colors to allow the user to further compare them to the basin-of-interest.

9.8.3.2 Mountains > 7,500 feet Elevation Peak Flow Envelope (Figure 30): This envelope covers the orographically-sheltered region of the interior and high elevation Rocky Mountains of Colorado. This envelope curve is significantly less extreme than that of the neighboring Eastern Plains/Foothills. For example, at 100 sqmi drainage area size, the Mountain envelope flow is about 10,500 cfs versus about 180,000 cfs for the Eastern Plains/Foothills envelope. Jarrett (1989) proposed the elevation limit of around 7,500 feet in Colorado’s Rocky Mountains for extreme rainfall-runoff driven flooding, above which, he and others found no paleo-flood or historical evidence of extreme rainfall-runoff floods in the past 10,000 years. The 7,500-foot elevation limit has been studied and generally corroborated over the ensuing 30 years. USGS StreamStats makes use of it, and the REPS study used it. The September 2013 storm and rainfall-driven flooding occurred at high elevations up to the Continental Divide, yet the magnitude of the flooding above 7,500 feet was simply nowhere near as extreme as record floods at lower elevations along the Front Range foothills. In fact, September 2013 peak flows do not control the peak flow envelope for either the Mountains or Foothills regions.

Colorado Dam Safety’s Mountain Region envelope curve (red line in Figure 30) is controlled by the 1976 Big Thompson flood and the 1945 Quartz Creek near Ohio flood at small area sizes (<10 sqmi). At 13.5 sqmi, the envelope is controlled by a USGS paleo-flood estimate on Cement Creek near Silverton with a reliability of 83-1000 years. At larger area sizes (>50 sqmi) the envelope is controlled by floods on the Huerfano River in the Sangre de Cristo range and by the Rio Grande River and
Vallecito Creek in the San Juan range. In terms of controlling Storm Types, the 1976 Big Thompson storm was classified by REPS as a Local Storm. The September 1970 flood on Vallecito Creek in the San Juans was classified by REPS as a General Storm (REPS Summary Report, Vol. II, 2018).

Peak flows from the July 1999 Saguache Creek flood, provided by Dr. Jarrett via email, are shown on the Mountain Region envelope plot as grey X’s in order to demonstrate the possibility that larger flows at small area sizes may have in fact been debris flows (Costa and Jarrett, 1981). Dr. Jarrett thoroughly investigated the Saguache Creek flood after-the-fact and concluded that several sites experienced debris flows (email dated March 19, 2021). He also investigated the Quartz Creek near Ohio flood indicators as part of his doctoral research at Colorado State University and concluded that these floods were likely debris flows (Jarrett, 1987). We included the Quartz Creek peak flows in our Mountain Region envelope because the USGS Colorado Flood Database recognizes them; however, Dr. Jarrett advised that the lower end of our Mountain Region envelope (<1 sqmi +/-) may be high and should be used with judgement (verbal communication). It is instructive to note that the Crippen and Bue (1977) envelope for their mountain region (Region 13) (green dash on Figure 30) is significantly higher than ours, because Crippen and Bue included peak flow locations below 7,500 feet elevation in their mountain region. At the time they did their work (1977), Jarrett’s 7,500-foot limit on extreme rain-driven flooding was not generally recognized.

9.8.3.3 Western Colorado < 7,500 feet elevation Peak Flow Envelope (Figure 31): Figure 31 applies to Colorado’s Western Slope below about 7,500 feet elevation, including the flanks of the San Juan Mountains, mesas and canyons of the Colorado Plateau region, and the Yampa and Green River basins in Northwest Colorado. In comparison to the other two regions, the Western Colorado envelope lies below the Mountain Region envelope at small area sizes (<2 sqmi +/-) -- see above discussion about debris flows -- then slightly above it at larger area sizes. The entire Western envelope lies far below the Eastern Plain/Foothills envelope. The Western envelope is notably controlled by late-season floods -- August, September and October -- in contrast to the other regions. The seasonality histograms in Figures 23-25, above, generally show more likely occurrence of late season extreme storms in the northwest and southwest regions for all storms types. At small drainage areas (<20 sqmi) the Western Colorado envelope is controlled by August and September floods on Piceance Creek near Rio Blanco, Badger Wash near Fruita and Red Canyon and No Thoroughfare Creeks near Grand Junction. The related storms were not used for the REPS PMP study, but at such small area sizes it can be assumed they were intense, convective storms. At larger area sizes (>100 sqmi), the envelope is controlled by the October 1911 (water year 1912) flood on the San Juan River at Pagosa Springs. This storm was a General Storm/Remnant Tropic Storm.

Crippen and Bue’s western region (Region 14) envelope is close to our Western Colorado envelope, except that the Crippen and Bue curve is higher at small drainage area sizes, where theirs is controlled by floods in Arizona, New Mexico, and Utah, not Colorado. It should also be noted that their western region (Region 14) includes the Colorado Plateau and western San Juan range, but not northwest Colorado, the latter of which they included in their mountain region (Region 13). This may in fact be more appropriate; however, in practice our Mountain and Western Colorado envelope curves are reasonably similar.
Figure 29: Observed peak flows and peak flow envelope for Colorado’s Eastern Plains and Front Range foothills <7,500 feet elevation. Red line is Colorado Dam Safety’s visually-estimated envelope; red dotted lines are our assumed +/-25% error bounds on discharge measurements.
Figure 30: Observed peak flows and peak flow envelope for Colorado’s Mountains >7,500 feet elevation. Red line is Colorado Dam Safety’s envelope. Red dotted lines are our assumed +/-25% error bounds on discharge measurements.
Figure 31: Observed peak flows and peak flow envelope for Colorado’s Western Slope <7,500 feet elevation. Red line is Colorado Dam Safety’s envelope. Red dotted lines are our assumed +/-25% error bounds on discharge measurements.
9.8.4 Using the peak flow envelope curves for reasonableness checks: Microsoft Excel files of Colorado Dam Safety’s Peak Flow Envelope plots can be downloaded from the following link to facilitate plotting and comparison of rainfall-runoff model discharges:

https://drive.google.com/drive/folders/1Q_Y6arM0Vd4NomgBB-U4NxTBOZ0zNz-c?usp=sharing

The recommended use of Figures 29-31 is to plot all modeled REPS PMP and probabilistic peak flows for comparison, along with other reasonableness checks data, discussed above, for the basin of interest -- historical flood peak flows, flood frequency estimates, etc. Regional 100-YR and 1000-YR flood frequency estimates should be plotted as well. Figure 32 below shows an example peak flow envelope plot with HEC-HMS REPS model results and data from reasonableness checks.

Our envelope curves are intended to provide a reasonableness check of extreme storm rainfall-runoff model results. In the past, unchecked extrapolation of rainfall-runoff models to extreme events appears to have led to design storms that are orders of magnitude beyond any observed floods, present or paleo. It is desirable to avoid those sorts of gross inaccuracies in order to more accurately identify and quantify dam safety risks. That said, the peak flow envelopes shown in red on Figures 29, 30 and 31 are simply visual fits of the maximum data; they are not intended to imply any theoretical function of flood production with respect to drainage area. Furthermore, observed peak flow measurements contain uncertainty; the USGS Colorado Flood Database rates its measurements on a qualitative scale of poor, fair, or good. Many extreme flood indirect (after-the-fact) flood discharge estimates are understandably rated poor with uncertainties of 20% or more. We have plotted +/-25% error bounds (red dotted lines) on our envelope curves to represent an approximate level of discharge measurement error. Finally, maximum flood production for a particular basin depends on many factors, not just drainage area, so the envelopes are not expected to provide an exact answer. The envelope curves are one tool of the many discussed in this section that can be used to make a case for defensible model results.

One of the most useful findings of the envelope plots is the regional differences in flood yields, particularly between the Eastern Plains/Front Range Foothills (Figure 29) versus the rest of the state (Figures 30 and 31). This regional difference has been shown by Jarrett (1989) and others, and it is implicit in REPS rainfall estimates via storm transposition boundaries. However, historically, design flood modeling many not have reflected these regional differences. Figures 33 and 34 below compare our three regional peak flow envelope curves in log-log space (Figure 33) and linear space (Figure 34). The linear graph in particular depicts the large regional differences in flood magnitudes. The error of many past dam safety design flood studies seems to be related to erroneous extrapolation/transposition of flooding from the Front Range foothills/ Eastern Plains to the rest of the state.

Finally, Figure 35 plots regional 100-YR flood frequency estimates from USGS StreamStats and from Bulletin 17C, along with the USGS Colorado Flood Database observed peak flows, for our Mountains region >7500 feet. There is a moderate amount of scatter in the 100-YR flood estimates, indicative of basin-specific variation, but in general they make a linear trend in log-log space, consistent with a power-function relationship between flood production and drainage area. In contrast, the observed peak flows and our envelope level off at larger drainage area sizes, say above around 75 sqmi. This may be because there are fewer large basins, and so the sample size of peak flows is smaller at larger areas. The plot suggests that the peak flow envelope may not correspond to a uniform return interval and may increase in likelihood of exceedance.
Figure 32: Example peak flow envelope with modeled REPS PF and PMF peak flows, as well as data from reasonableness checks.
Figure 33: Comparison of Colorado Dam Safety’s three regional peak flow envelope curves in log-log space.

Figure 34: Comparison of Colorado Dam Safety’s three regional peak flow envelope curves in linear space.
with increasing area size. If this is the case, then the envelope curves may not represent an upper limit at larger area sizes. On the other hand, Crippen and Bue (1977) and Wolman and Costa (1982) used non-linear log-log envelopes like ours, and they do not indicate a significant or larger increase in the curves at larger area sizes since at least 1948. Research by Laurenson and Kuczera (1999) and Nathan et al (2016) on notional AEP of PMP (i.e., the likelihood corresponding to estimates of flood upper limits) calculated lower notional AEP of PMP for smaller area sizes and shorter durations, possibly consistent with what we see in Figure 35. Lastly, the shape of the observed flood data and our envelope could indicate physical limits on storm size and contributing areas of flooding on larger basins in Colorado or a change in storm type altogether controlling flooding on larger basins, e.g. from rain-driven flooding to snowmelt. This could suggest inaccuracies in flood frequency estimates as much as the peak flow envelopes. In summary, peak flow envelopes are extremely useful, but should be used with judgment.

9.9 Upper Tail Ratios: The Upper Tail Ratio (UTR) is a statistic defined by Smith et al (2018) as the ratio of maximum observed flood to the 10-YR flood frequency estimate for a basin. The UTR may serve as a good reasonableness check because it combines maximum observed flood data with a basin specific flood frequency estimate, thereby capturing basin-scale variations. An implication of Figure 35 is that UTR may decrease with larger area sizes. In fact cursory analysis by Colorado Dam Safety indicate as much (see Table 10, Figures 36 and 37). Table 10 tabulates

![Image of Figure 35: Regional 100-YR flood frequency estimates by USGS StreamStats and by Bulletin 17C at selected sites in the USGS Colorado Flood Database, overlaid on observed peak flows and the peak flow envelope for our Mountain <7,500 feet elevation region.](image-url)
Table 10: Upper tail ratios for envelope-controlling peak flows in Colorado Dam Safety’s Mountain <7,500-ft elevation region

<table>
<thead>
<tr>
<th>Flood event location &amp; description</th>
<th>DA (sqmi)</th>
<th>Observed Qpeak</th>
<th>StreamStats Q10</th>
<th>UTR (Qpeak/Q10)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example Dam Inflow Design Flood</td>
<td>2.18</td>
<td>5045</td>
<td>109.9</td>
<td>119</td>
<td></td>
</tr>
<tr>
<td>Observed floods by relevant REPS storm transection zones (ser.: T2 5, 6 &amp; 9 Peak Flow Envelope curve)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T25: Rangely de Cristo Range &amp; san Juan Range rain of CD, 7500 ft elev</td>
<td>73</td>
<td>10200</td>
<td>409</td>
<td>25</td>
<td>Eastern slope of Sangre de Cristo Range</td>
</tr>
<tr>
<td>T25 #2 (Indian) Puertito R. at Manzanos Crossing, rain, 7/7/1972 (good flow)</td>
<td>73</td>
<td>8520</td>
<td>409</td>
<td>16</td>
<td>Eastern slope of Sangre de Cristo Range</td>
</tr>
<tr>
<td>T26 #1 (Indian) San Francisco Creek at Del Norte, 7/29/1968 (Good)</td>
<td>11.8</td>
<td>754</td>
<td>154</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>T26 #6 (Indian) North Cresent Creek at Cresent, 8/8/1966 (Unknown flow)</td>
<td>10.7</td>
<td>755</td>
<td>139</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>T26 #8 (Indian) Cresent Creek at Cresent, 7/26/1968 (Good flow)</td>
<td>0.77</td>
<td>940</td>
<td>85</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>T26 #31 (gaged): Alamosa Creek above Terrace Res., 10/31/1972</td>
<td>107</td>
<td>5200</td>
<td>1550</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>T35: East Range &gt;7500 ft elev, east of C.D.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#5: Sand Creek at Gunnison State Park, July 1977 (gaged Data)</td>
<td>29.2</td>
<td>6720</td>
<td>269</td>
<td>24</td>
<td>Ralston Mountain</td>
</tr>
<tr>
<td>#7: Little Thompson R. at Estes Park, July 1936 (flow Data)</td>
<td>2.27</td>
<td>3940</td>
<td>31</td>
<td>33</td>
<td></td>
</tr>
<tr>
<td>T35 (West Slope &gt;7500 ft elev)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#2: Vallecito Creek near Bayfield, CO (La Plata County), Sept. 5, 1975, Good Rating</td>
<td>72.3</td>
<td>7050</td>
<td>1080</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>#3: Mineral Creek at Silverton, CO (San Juan County), Sept. 5, 1970, Good Rating</td>
<td>42.2</td>
<td>2070</td>
<td>850</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>#12: Pickel Gulch trib to Quartz Creek n. Ohio, CD (Gunnison County), July 31, 1945, Unknown Rating</td>
<td>0.7</td>
<td>750</td>
<td>126</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>#17: Unnamed Gulch trib to Quartz Creek n. Ohio, CD (Gunnison Co.), July 31, 1945, Unknown Rating</td>
<td>0.2</td>
<td>440</td>
<td>3.07</td>
<td>116</td>
<td></td>
</tr>
</tbody>
</table>

Figure 36: Upper tail ratios (UTRs) for the Mountain region envelope-controlling peak flows in Table 10, along with a comparison of a modeled design flood UTR for a basin-of-interest.
Figure 37: Ratio of observed peak flows to 100-YR flood estimates at selected sites from the USGS Colorado Flood Database in our Mountains < 7,500-ft elevation region, the same sites that flood frequency estimates are plotted for in Figure 35.

UTRs corresponding to envelope-controlling peak flows for our Mountains <7,500-ft elevation region peak flow envelope. The Table 10 UTRs are plotted against drainage area size in Figure 36 indicating decreasing UTR with area size. The calculated UTRs at small areas are high compared to those reported by Smith et al (2018); however, Smith et al generally looked at larger gaged basins in the NWIS database. Figure 36 also plots the UTR calculated for an example model design flood in comparison to the UTRs for observed floods, illustrating how UTRs may provide another reasonableness check of model results. Smith et al (2018) showed strong regional differences in UTRs (refer back to Figure 4 above), which may also be useful for model evaluation.

Figure 37 shows Q100 upper tail ratios (i.e. peak flow divided by 100-YR flood estimate) at the same selected locations as the flood frequency estimates plotted in Figure 35. Again there seems to be a drainage area dependence for the largest upper tail ratios.

9.10 Previous Hydrology Studies: Previous hydrology studies can be a good source of past information, floods and analysis. Although their methods may be outdated, the results often provide a good point of comparison for explaining why current results differ. Previously study results should be concisely summarized for comparison.

9.11 Confidence: The reasonableness checks described above are firstly intended to evaluate rainfall-runoff model accuracy. However, they should also be used to build confidence. For risk-informed decision making, Colorado Dam Safety ranks confidence as Strong, Medium, or Poor (see Table 11 below). The USBR (2004) and others have defined limits of
Table 11: Example confidence ratings from Colorado Dam Safety’s Guidelines for Comprehensive Dam Safety Evaluation (CDSE) Risk Assessments & Risk Informed Decision Making (RIDM), March 2021.

<table>
<thead>
<tr>
<th>Confidence Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STRONG</td>
<td>The team is confident in the risk characterization, and it is unlikely that additional information would change the order of magnitude of the assigned category to the point where the decision to take (or not take) action to reduce risk or reduce uncertainty would change.</td>
</tr>
<tr>
<td>MEDIUM</td>
<td>The team is relatively confident in the risk characterization, but key additional information might possibly change the order of magnitude of the assigned category to the point where the decision to take (or not take) action to reduce risk or reduce uncertainty may change.</td>
</tr>
<tr>
<td>POOR</td>
<td>The team is not confident in the risk characterization, and it is entirely possible that additional information would change the order of magnitude of the assigned category to the point where the decision to take (or not take) action to reduce risk or reduce uncertainty could change.</td>
</tr>
</tbody>
</table>

credible flood frequency curve extrapolation in terms of the quality of available flood data (see Table 12 below). Finally Nathan and Weinmann (2001) depict flood estimation procedures and uncertainties by AEP (see Figure 38).

Table 12: USBR recommended limits on flood frequency extrapolation (Swain et al, 2004)

<table>
<thead>
<tr>
<th>Type of data used for flood frequency analysis</th>
<th>Limit of credible extrapolation for annual exceedance probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>At-site streamflow data</td>
<td>Typical: 1 in 100</td>
</tr>
<tr>
<td>Regional streamflow data</td>
<td>Typical: 1 in 500</td>
</tr>
<tr>
<td>Regional precipitation data</td>
<td>Typical: 1 in 2,000</td>
</tr>
<tr>
<td>At-site streamflow and at-site paleoflood data</td>
<td>Typical: 1 in 4,000</td>
</tr>
<tr>
<td>Regional streamflow and regional paleoflood data</td>
<td>Typical: 1 in 15,000</td>
</tr>
<tr>
<td>Combinations of regional data sets and extrapolation</td>
<td>Typical: 1 in 40,000</td>
</tr>
<tr>
<td></td>
<td>Optimal: 1 in 200</td>
</tr>
<tr>
<td></td>
<td>Optimal: 1 in 1,000</td>
</tr>
<tr>
<td></td>
<td>Optimal: 1 in 10,000</td>
</tr>
<tr>
<td></td>
<td>Optimal: 1 in 10,000</td>
</tr>
<tr>
<td></td>
<td>Optimal: 1 in 40,000</td>
</tr>
<tr>
<td></td>
<td>Optimal: 1 in 100,000</td>
</tr>
</tbody>
</table>
In terms of confidence, we propose here that the following qualitative assessment of confidence can be made, to facilitate Colorado Dam Safety risk analysis, based on (1) REPS rainfall and CSU mountain hydrology model confidence, (2) quality and amount of historical flood data that results from the above reasonableness checks, and (3) magnitude of storms/floods of interest:

**Strong confidence**: Confidence in REPS PMP storm transpositions and REPS AEP estimates; hydrologically similar basins to those CSU-SMA research used for calibration and verification. Stream gage data for basin-of-interest, paleo-flood estimates, long (80-100 years) records of flows at an existing dam, or regional study of hydrologically similar basins with flood frequency curves out to 10,000 YR ARI estimates. Good agreement is found between multiple lines of evidence, e.g., flood frequency estimates, seasonality, controlling storm types, historical floods, etc. vs. rainfall-runoff model results. Floods of interest out to 1/100,000 years for optimal data.

**Medium confidence**: Confidence in REPS PMP storm transpositions and REPS AEP estimates; hydrologically similar basins to those CSU-SMA research used for calibration and verification. Good regional flood estimates are available (e.g. StreamStats and peak flow envelopes) within range of hydrologically similar data sets. Good agreement is found between multiple lines of evidence, e.g., seasonality, controlling storm types, historical floods, etc. vs. rainfall-runoff model results. Estimates beyond 1/100,000 years for optimal data.

**Poor confidence**: Less confidence in REPS PMP storm transpositions and wider confidence bounds on REPS AEP estimates. Only regional flood estimates (e.g. StreamStats, peak flow envelopes) are available for reasonableness checks and require extrapolation beyond range of datasets (i.e. very small or very large drainage basins or basins that otherwise do not fit datasets, like urban developments). Minimal lines of evidence are available to substantiate model calibration, besides extrapolation of these regional estimates. Estimates beyond 1/100,000 years with less than optimal data.
Section 10. CSU-SMA Model Parameter Calibration

10.1 Traditionally extreme floods for dam safety in Colorado were estimated by extrapolation of uncalibrated rainfall-runoff models to extreme storms, often with unreasonably conservative results -- several orders of magnitude larger than observed floods in some cases. In contrast, current agency thinking is that sufficient extreme flood data exists to allow model calibration in order to improve accuracy of model estimates. The rational extension of the reasonableness checks described in the previous section is to adjust rainfall-runoff models to produce general agreement, to the extent possible, to the various checks -- flood frequency curves, controlling flood seasonality, historical flooding at dams, regional peak flow envelopes, etc. Industry precedence exists for calibration of modeled flood-frequency estimates to observed flood-frequency curves (Novembre and Wright, 2013; Schaefer et al, 2012; and Schaefer and Barker, 2005).

10.2 The following procedure is recommended for model calibration⁴ (see Appendix C for a Model Parameter Calibration Checklist/template):

- Determine the most likely controlling storm type for the basin based on area size, type of historical storms/floods, and seasonality of historical/observed floods. If there is no clear controlling storm type for a basin-of-interest, then calibrate all modeled storm types.

- Calibrate the HEC-HMS model parameters based on the assumption of AEP neutrality (i.e., a given AEP storm yields the same AEP flood peak) such that the REPS 10e-2 controlling storm type peak flow is reasonably close to the observed flood frequency estimate (e.g. Bulletin 17C Q100, scaled Q100, StreamStats 100YR peak flow estimate, etc.). Reasonably close should mean within 90% confidence bounds for Bulletin 17C flood frequency curves, within the standard error of prediction for StreamStats, or generally within +/-20%. Recommendations are provided below in terms of which model parameters should be adjusted based on controlling storm type and controlling flood production mechanism.

- Similar comparisons should be made at 2x10e-3 (500-YR) and 10e-3 (1000-YR), by extrapolation of observed flood frequency curves, if needed. Consideration should be given to calibrating to paleo-flood estimates on the basin-of-interest or hydrologically similar basins, using the estimated paleo-age.

- Next, the model should be calibrated at the upper end, by calibrating modeled REPS PMF for the controlling storm type to the Colorado Dam Safety regional peak flow envelopes:
  - Based on Colorado Dam Safety experience, the Front Range/Eastern Plains envelope is very extreme, often above traditional dam safety PMFs, and therefore we recommended calibrating the REPS PMF directly to the envelope peak flow, within our assumed +/-25% measurement error (red dotted lines on Figure 29).
  - For the Mountains (>7500 ft) and Western Slope regions, we recommend calibrating the controlling REPS PMF to (1.5 x envelope peak flow), as a factor of safety. The 1.5 scaling factor is consistent with the maximum in-place maximization factor applied to historical extreme precipitation used for REPS PMP.
  - (Note: where basins span multiple regions, then weighted average envelope peak flow may be used or use partial area analysis in the controlling region).

- Particularly for the Front Range & Eastern Plains region, if the rainfall-runoff model cannot be calibrated to work at both upper and lower ends (i.e. PMF to the peak flow envelope and 100-YR to flood frequency curve), then consideration should be given using non-linear runoff transformation, for example, by HEC-HMS’s Variable Clark UH method or using HEC-HMS's Atmospheric Moisture Factor (1.07), to Inflow Design Floods. See the next page for more details.

---

⁴ Model calibration should be performed prior to applying Dam Safety Rule 7.2.4, Atmospheric Moisture Factor (1.07), to Inflow Design Floods. See the next page for more details.
RAS 2D. In HMS's Clark Variable method, Tc and R parameters can be decreased for increasing excess precipitation to allow calibration of the 100-YR flood, PMF to the peak flow envelope, and other intermediate points (ex. 1000-YR flood, paleo-flood, etc.). These calibration points can be used to define a percentage curve table of %Tc and %R versus %excess precipitation (relative to an index value).

- Next, other reasonableness checks from Section 9 should be used to inform the model calibration. For example, model parameters should be adjusted to produce general agreement with record pool, record inflows or record dam overtopping over the lifetime of an existing dam, historical frequency of spillway activation, historical large floods, historical storm types and seasonality of flooding, etc.

The following additional considerations are offered for model calibration:

- Calibration to regional peak flow envelopes may not capture basin-specific differences. Our experience is that the regional differences that are captured by the regional envelope curves far out-weigh basin-specific differences (when compared for historical hydrology studies that ignored regional differences). Nevertheless, basin-specific deviations from regional data sets may be warranted if they can be adequately justified. Calibration to flood frequency estimates by bulletin 17C and even StreamStats may provide valuable information about basin-specific variations.

- Notional AEP of PMP and PMF can be determined by comparing REPS PMP results against REPS precipitation frequency (see Sections 4 and 8 above). This cross-check is a strength of REPS. Where notional AEP of REPS PMP/PMF is far less than 10e-7, then the modeled PMF may plot far above the regional peak flow envelopes. In such cases the State Engineer may grant a waiver to State Dam Safety Rule 7.2, allowing an acceptable risk-based probabilistic IDF criteria less than deterministic PMP.

- Climate change has the potential to increase flood yields in Colorado in the future (REPS Summary Report, Vol. VI). Based on the recommendations by NOAA and others, Colorado Dam Safety implemented Dam Safety Rule 7.2.4, Atmospheric Moisture Factor (AMF), which requires that rainfall estimates for determining inflow design floods shall be multiplied by 1.07 to account for expected increases in temperature and moisture-holding capacity of the atmosphere over the next 50 years. This factor must be applied to IDFs for new dams, enlargements, and spillway design projects to account for the expected design life; it should be applied after hydrology model calibration. Generally the AMF should not be applied for hydrologic risk studies and evaluation of the safety of existing dams, because risk-analysis reflects current conditions.

- Where observed peak flows and historical flooding are dominated by snowmelt, which is true for many basins above 7,500 feet elevation in Colorado, then rainfall flood frequency estimates are necessarily lower, at least within the period of record. However, the general assumption is that rainfall flooding will exceed snowmelt flooding at some extreme AEP (i.e. steeper flood frequency curve), although Jarrett and Tomlinson (2000) said this assumption is not supported by paleo-flood data out to 10,000 years based on their study in northwest Colorado. Nevertheless, the conservative and recommended approach here is to calibrate the likely controlling REPS storm type (or all three storm types) to the snowmelt-based 100-YR flood frequency estimate, per the calibration procedure described above, unless paleo-flood or other evidence suggests some other ARI. This approach is considered to be conservative, but still reasonably supported by the magnitude of historical flooding. Alternatively, a baseflow may be used in HEC-HMS to make up the difference between the modeled REPS and flood frequency 100-YR floods, assuming this difference is due to snowmelt.
• As discussed in Section 9, advanced studies may use event calibration to historical floods. If possible, independent verification should be done on multiple historical storms/floods. This approach is only expected for large basins and as warranted by dam size or hazard potential. Most dams in Colorado are on ungaged basins, and calibration to historical floods will not be possible.

10.3 This section provides information on specific CSU-SMA model parameters for calibration. Select parameters can be adjusted based on controlling storm type and controlling runoff mechanisms in order to better match historical flooding:

- **Impervious (%):** The percentage of sub-basin area that will not infiltrate/store any precipitation. These areas will always produce surface runoff. Increasing impervious area will tend to produce larger surface runoff, particularly from high-intensity rainfall.

- **Soil % (Initial soil moisture):** The percentage of soil storage occupied by water at the beginning of the storm. Special care should be applied when setting this value. If the initial soil moisture is set higher than tension storage, the model will start in a phase of discharge from subsurface stormflow and may overestimate the rising limb of the hydrograph. High initial soil moisture may also lead to saturation-excess runoff.

- **Maximum Infiltration Rate (in/hr):** Maximum rate at which water can enter soil storage. The actual infiltration rate varies as a function of available soil storage. Higher available soil storage translates to an infiltration rate closer to the specified maximum. Increasing maximum infiltration rate will tend to produce less infiltration-excess runoff.

- **Soil Storage (inches):** This value represents the maximum amount of water that can be stored in the soil layer and directly affects infiltration rate (see above). Lower soil storage may lead to soil saturation and saturation-excess runoff.

- **Tension Storage (inches):** This value is the portion of soil storage that must be overcome before water can leave the soil layer and enter the groundwater layer via soil percolation. Higher tension storage values can restrict/delay subsurface stormflow. Mainly applicable where long-duration General Storms control the design flood; decreasing tension storage will increase sub-surface flow associated with low intensity rainfall.

- **Max Soil Percolation Rate (in/hr):** Maximum rate at which water leaves the soil layer and enters the groundwater layer. Like max infiltration, this rate is a function of soil storage. This rate only comes into play once tension storage is overcome. Constricting this value can force saturation-excess runoff to occur. If this parameter is higher, the model will produce more subsurface stormflow instead of saturation-excess runoff.

- **GW % (GW saturation):** defines the percentage of groundwater storage occupied by water at the beginning of the storm. The CSU-SMA method assumes this value is zero since flow before the rising limb of the observed hydrographs remains nearly constant. Starting a simulation with water in the GW layer is similar to when initial soil moisture is above the tension storage threshold and the soil percolation rate is high (i.e. may cause overestimation of early storm flows by subsurface stormflow).

- **GW Storage (inches):** Represents the maximum amount of water that can be stored in the GW layer. Large values for this parameter result in models that emphasize the subsurface component of the hydrograph. Reducing this value can force saturation excess runoff for long duration storms. However, using small values for this parameter means that groundwater layer is usually saturated. This creates a near-constant discharge from this layer that is not as sensitive to changes in precipitation. Woolridge (2019) showed that using small values for GW storage can accurately simulate subsurface stormflow dominant hydrographs (i.e. Bear Creek, Sept. 2013 flood).

- **GW Time Coefficient (hr):** This parameter controls the rate at which water is released from the groundwater layer. Shorter time constants lead to increased subsurface stormflow with similar timing as surface runoff. Models using shorter time constants are also more sensitive to changes in precipitation. Models using longer time constants result in more attenuated hydrographs that are not as sensitive to changes in precipitation. Where subsurface flood flows are significant, calibration of this parameter may be necessary in
order to make subsurface and surface peaks coincide, i.e., to avoid a double peak
hydrograph.

- **GW Percolation Rate (in/hr):** This parameter determines net loss to the system and can help with adjusting flood volume. For the CSU-SMA method it was determined through calibration to historical floods in both the Front Range and San Juans. The value in the Front Range basins (2 - 3 mm/hr) is higher than that in the San Juans (0.5 - 1 mm/hr). Changing this value can have large effects on peak flows and volume.

- **Linear Reservoir Coefficient (hr):** This parameter controls the rate at which water that has left the groundwater layer is routed to the stream. Effects of changing this parameter are similar to those listed in the “GW Time Coefficient” description.

- **Clark Unit Hydrograph Time of Concentration (hr):** $T_c$ generally represents channel storage and travel time through the basin stream network. Decreasing $T_c$ will produce larger peak flows and flashier surface runoff hydrographs. See discussions above about use of Clark Variable method to produce non-linear runoff response, i.e., flashier runoff response with increasing rainfall intensity and excess precipitation.

- **Clark Unit Hydrograph Storage Coefficient (hr):** $R$ generally represents hillslope storage in the basin. Decreasing $R$ will have a similar effect as decreasing $T_c$, producing larger peak flows and flashier surface runoff hydrographs.

10.4 The following additional guidance is provided on parameter calibrations for emphasizing different runoff production mechanisms:

- **For Infiltration-Excess Runoff:**
  - **Max infiltration rate:** Reduction of infiltration rate will force more excess precipitation leading to higher peak flows and volumes of infiltration-excess runoff by intense REPS Local Storms.
  - **Impervious Area:** Increasing the impervious area can result in higher runoff peak flows and volumes and overall quicker response runoff.

- **For Saturation-Excess Runoff:**
  - **Reduce soil storage, increase tension storage to a value closer to soil storage, and reduce soil percolation rate:** Less soil storage for water to fill up will cause saturation-excess runoff to occur. Increasing the tension storage capacity would allow water (both pre-event and event) to remain in the soil layer longer without draining to the groundwater layer. Reducing the rate water is transferred from the soil layer to the groundwater layer leads to the soil layer filling up earlier.
  - **Increase GW time coefficient:** This method is not as direct as the preceding ones, but creates a back-up of groundwater into soil storage. Longer time constants translate to a slower subsurface flow response. However, slowing the groundwater flow can lead to dissimilar timing with surface runoff and create an unrealistic double-peak effect in the output hydrograph.

- **Subsurface Stormflow:**
  - **Increase GW storage:** Since subsurface stormflow is modeled as a linear reservoir, increasing the storage will increase the magnitude of outflow. If there is a combination of high subsurface flow and surface runoff, this adjustment may cause an unrealistic double-peak effect due to the differences in timing of the two flow components. This usually takes the form of an early spike in the hydrograph from saturation-excess runoff, followed by large volumes of subsurface flow.
  - **Reduce GW time coefficient:** Reducing the time coefficient speeds up the rate water is released from the groundwater layer. If reduced enough, resulting subsurface stormflow hydrographs could look like surface runoff hydrographs.
  - **Reduce GW percolation rate:** By reducing system loss, more water is available from the storm to translate to streamflow. This parameter can change runoff mechanisms and flow volumes drastically in some cases.
Section 11. Acknowledgements

We would like to acknowledge the efforts and expert guidance of Dr. Jeff Niemann and his graduate students Doug Woolridge and Ben Irvin, in their mountain hydrology research study and development of the CSU-SMA modeling method.

We would also like to acknowledge Dr. Robert Jarrett, retired USGS, for his tireless efforts to improve understanding of floods in Colorado. Many others have helped.

Finally we would like to thank the peer reviewers and subject matter expert reviewers for their time and input towards improving these guidelines.
Section 12. References (link to DWR Google Drive)

Alberta Ministry of Transportation,  
http://www.transportation.alberta.ca/Content/docType30/Production/fldenvcurv.pdf, undated.


Colorado-New Mexico Regional Extreme Precipitation Study Summary Report, Volume 1, Colorado Department of Natural Resources and New Mexico Office of the State Engineer, November 30, 2018.


Guidelines for Comprehensive Dam Safety Evaluation (CDSE) Risk Assessments & Risk Informed Decision Making (RIDM), Colorado Dam Safety, March 2021

Guidelines for the Use of Regional Extreme Precipitation Study (REPS) Rainfall Estimation Tools, Colorado Dam Safety Branch, January 21, 2020

Guidelines for Hydrologic Hazard Analysis, Colorado Dam Safety Branch, January 21, 2020


Perry, Mark, Jeremy Franz, Casey Dick and Bill Kappel, Advances in Flood Hydrology for Modeling High Elevation Basins in Colorado with Applications to the Gross Dam Enlargement Study, Association of State Dam Safety Officials, 2017


Appendix A
Example Report Requirements & Reasonableness Checks Summaries
Appendix B

CSU-SMA python script
Appendix C
Reporting checklists
Appendix D
Subject Matter Expert Review